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1. Creating a Partial Reconfiguration Design
Partial reconfiguration (PR) allows you to reconfigure a portion of the FPGA
dynamically, while the remaining FPGA design continues to function. You can define
multiple personas for a particular region in your design, without impacting operation in
areas outside this region. This methodology is effective in systems with multiple
functions that time-share the same FPGA device resources. PR enables the
implementation of more complex FPGA systems. The Intel® Quartus® Prime Pro
Edition software supports the PR feature for the Intel Arria® 10 and Intel Stratix® 10
device families.

Figure 1. Partial Reconfiguration Design
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PR provides the following advancements over a flat design:

• Allows run-time design reconfiguration

• Increases scalability of the design through time-multiplexing

• Lowers cost and power consumption through efficient use of board space

• Supports dynamic time-multiplexing functions in the design

• Improves initial programming time through smaller bitstreams

• Reduces system down-time through line upgrades

• Enables easy system update by allowing remote hardware change

Note: The current version of the Intel Quartus Prime Pro Edition software introduces a
simplified compilation flow for partial reconfiguration.

Hierarchical Partial Reconfiguration

Intel Quartus Prime Pro Edition software also supports hierarchical partial
reconfiguration (HPR), with multiple parent and child design partitions, or multiple
levels of partitions in a design. In HPR designs, a static region instantiates a parent PR
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region, and a parent PR region instantiates a child PR region. The same PR region
reprogramming is possible for the child and parent partitions. Refer to the Partial
Reconfiguration Tutorials for detailed HPR instructions.

Static Update Partial Reconfiguration

Static update partial reconfiguration (SUPR) allows you to define and modify a
specialized static region, without requiring recompilation of all personas. This
technique is useful for a portion of a design that you may possibly want to change for
risk mitigation, but that never requires runtime reconfiguration. In PR without an
SUPR partition, you must recompile all personas for any change to the static region.
Refer to the Partial Reconfiguration Tutorials for detailed SUPR instructions.

Partial Reconfiguration Design Simulation

The Intel Quartus Prime Pro Edition software supports simulation of PR persona
transitions through use of simulation multiplexers. You use the simulation multiplexers
to change which persona drives logic inside the PR region during simulation. This
simulation allows you to observe the resulting change and the intermediate effect in a
reconfigurable partition. Refer to Partial Reconfiguration Design Simulation on page
37 for details.

Related Information

• Partial Reconfiguration Tutorials

• Intel Stratix 10 Device Overview

• Intel Stratix 10 Configuration User Guide

• Intel Arria 10 Device Overview

• Intel Arria 10 Configuration User Guide

• Intel Arria 10 Reconfiguration Interface and Dynamic Reconfiguration

1.1. Partial Reconfiguration Terminology

This document refers to the following terms to explain partial reconfiguration:

Table 1. Partial Reconfiguration Terminology

Term Description

Floorplan The layout of physical resources on the device. Creating a design floorplan, or
floorplanning, is the process of mapping logical design hierarchy to physical
regions in the device.

Hierarchical Partial Reconfiguration Partial reconfiguration that includes multiple parent and child design
partitions, or nesting of partitions in the same design.

PR control block A dedicated block in Intel Arria 10 FPGAs. The PR control block processes the
PR requests, handshake protocols, and verifies the cyclic redundancy check
(CRC).

PR host The system for coordinating PR. The PR host communicates with the PR
control block (Intel Arria 10 designs) or Secure Device Manager (Intel Stratix
10 designs). Implement the PR host within the FPGA (internal PR host) or in a
chip or microprocessor.

PR partition Design partition that you designate as Reconfigurable. A PR project can
contain one or more PR partitions.

continued...   
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Term Description

PR Solutions Intel FPGA IP Suite of Intel FPGA IP that simplify implementation of PR handshaking and
freeze logic.

PR region An area in the FPGA that you associate with a partially reconfigurable
partition. A PR region contains the core locations of the device you want to
reconfigure. A device can contain more than one PR region. A PR region can
be core-only, such as LAB, RAM, or DSP.

PR persona A specific PR partition implementation in a PR region. A PR region can contain
multiple personas. Static regions contain only one persona.

Revision A collection of settings and constraints for one version of your project. An
Intel Quartus Prime Settings File (.qsf) preserves each revision of your
project. Your Intel Quartus Prime project can contain several revisions.
Revisions allow you to organize several versions of your design within a single
project.

Secure Device Manager (SDM) A triple-redundant processor-based Intel Stratix 10 FPGA block that performs
authentication, decryption, and decompression on the configuration data the
block receives, before sending the data over to the configurable nodes
through the configuration network.

Snapshot The output of a Compiler stage. The Intel Quartus Prime Pro Edition Compiler
generates a snapshot of the compiled database for each partition, after each
compilation stage. Export the snapshot at various stages of the compilation
flow, such as synthesized, placed, or final.

Static region All areas outside the PR regions in your project. You associate the static
region with the top-level partition of the design. The static region contains
both the core and periphery locations of the device.

Static update partial reconfiguration A static region that allows change, without requiring the recompilation of all
personas. This technique is useful for a portion of a design that you may
possibly want to change for risk mitigation, but that never requires runtime
reconfiguration.

Related Information

Partial Reconfiguration Solutions IP User Guide on page 49

1.2. Partial Reconfiguration Process Sequence

Your partial reconfiguration design initiates the PR operation, and delivers the
configuration file to the PR control block (Intel Arria 10 designs) or SDM (Intel Stratix
10 designs). Before partial reconfiguration, you must ensure that the FPGA device is in
user mode, and in a functional state. The following steps describe the partial
reconfiguration sequence:

1. Send the stop_req signal to the PR region from the sequential PR control logic to
prepare for the PR operation. Upon receiving this signal, the PR regions complete
any pending transactions and stop accepting new transactions.

2. Wait for the stop_ack signal to indicate that the PR region is ready for partial
reconfiguration.

3. Use PR control logic to freeze all necessary outputs of the PR regions. Additionally,
drive the clock enable for any initialized RAMs to disabled state.

4. Send the PR bitstream to the to the PR control block (Intel Arria 10 designs) or
SDM (Intel Stratix 10 designs) to initiate the PR process for the PR region. When
using any of the Partial Reconfiguration Controller Intel FPGA IP, the Avalon®-MM
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or Avalon-ST interface on the IP core provides this functionality. When directly
instantiating the PR control block for Intel Arria 10 designs, refer to Intel Arria 10
PR Control Block Signal Timing Diagrams on page 69

5. On successful completion of the PR operation, reset the PR region.

6. Signal the start of PR operation by asserting the start_req signal, and
deasserting the freeze signal.

7. Wait for the start_ack signal to indicate that the PR region is ready for
operation.

8. Resume operation of the FPGA with the newly reconfigured PR region.

Figure 2. PR Process Sequence Timing Diagram
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1.3. Internal Host Partial Reconfiguration

In internal host control, an internal controller, a Nios® II processor, or an interface
such as PCI Express* (PCIe*) or Ethernet, communicates directly with the Intel Arria
10 PR control block, or with the Intel Stratix 10 SDM.

To transfer the PR bitstream into the PR control block or SDM, use the Avalon-MM
interface on the Intel Arria 10 or Intel Stratix 10 Partial Reconfiguration IP core. When
the device enters user mode, initiate partial reconfiguration through the FPGA core
fabric using the PR internal host.

Note: If you create your own control logic for the PR host, the logic must meet the PR
interface requirements.
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Figure 3. Internal Host PR
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When performing partial reconfiguration with an internal host, use the dedicated PR
pins (PR_REQUEST, PR_READY, PR_DONE, and PR_ERROR) as regular I/Os. Implement
your static region logic to retrieve the PR programming bitstreams from an external
memory, for processing by the internal host.

Figure 4. Intel Arria 10 FPGA System Using an Internal PR Host
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Send the programming bitstreams for partial reconfiguration through the PCI Express
link. Then, you process the bitstreams with your PR control logic and send the
bitstreams to the PR IP core for programming.
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1.4. External Host Partial Reconfiguration

In external host control, an external FPGA or CPU controls the PR configuration using
external dedicated PR pins on the target device. When using an external host, you
must implement the control logic for sending the bitstream to the hard FPGA
programming pins.

Figure 5. PR System Using an External Host (Intel Arria 10 Example)
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Related Information

• Configuring an External Host for Intel Arria 10 Designs on page 71
for a description of external configuration PR pins

• Partial Reconfiguration External Configuration Controller Intel Stratix 10 FPGA IP
on page 74

• Configuring an External Host for Intel Stratix 10 Designs on page 76
for a description of external configuration PR pins

1.5. Partial Reconfiguration Design Considerations

Partial reconfiguration is an advanced design flow in the Intel Quartus Prime Pro
Edition software. Creating a partial reconfiguration design requires understanding the
PR design considerations and guidelines for the PR flow. When designing for partial
reconfiguration, you must consider the entire system-level behavior initial conditions
to maintain the integrity and correctness of the static region operation.

For example, during PR programming, you must ensure that other parts of the system
do not read or write to the PR region. You must also freeze the write enable output
from the PR region into the static region, to avoid interference with static region
operation. If all personas for your design do not have identical top-level interfaces,
you must create the wrapper logic to ensure that all the personas appear similar to
the static region. Upon partial reconfiguration of a PR region, you must bring the
registers in the PR region to a known state by applying a reset sequence. There are
specific guidelines for global signals and on-chip memories. The following sections
provide design considerations and guidelines to help you create design files for a PR
design.

1. Creating a Partial Reconfiguration Design
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FPGA Device and Software Considerations

• Only Intel Arria 10 devices in -1, -2 and -3 speed grade support partial
reconfiguration. All Intel Stratix 10 devices support PR.

• Use the nominal VCC of 0.9V or 0.95V as per the datasheet, including VID enabled
devices.

• The Intel Quartus Prime Standard Edition software does not support partial
reconfiguration for Intel Arria 10 devices, nor provide any support for Intel Stratix
10 devices.

• To minimize Intel Arria 10 programming files size, ensure that the PR regions are
short and wide. For Intel Stratix 10 designs, use sector-aligned PR regions.

• The current version of the Intel Quartus Prime Pro Edition software supports only
one Signal Tap File (.stp) per revision.

Design Partition Considerations

• Reconfigurable partitions can only contain core resources, such as LABs, RAMs,
and DSPs. All periphery resources, such as the transceivers, external memory
interface, HPS, and clocks must be in the static portion of the design.

• To physically partition the device between static and individual PR regions,
floorplan each PR region into exclusive, core-only, placement regions, with
associated routing regions.

• A reconfiguration partition must contain the super-set of all ports that you use
across all PR personas.

Clocking, Reset, and Freeze Signal Considerations

• The maximum number of clocks or other global signals for any Intel Arria 10 PR
region is 33. The maximum number of clocks or other global signals for any Intel
Stratix 10 PR region is 32 .In the current version of the Intel Quartus Prime Pro
Edition software, no two PR regions can share a row-clock.

• PR regions do not require any input freeze logic. However, you must freeze all the
outputs of each PR region to a known constant value to avoid unknown data
during partial reconfiguration.

• Increase the reset length by 1 cycle to account for register duplication in the
Fitter.

1.5.1. Partial Reconfiguration Design Guidelines

The following table lists important design guidelines at various steps in the PR design
flow:

Table 2. Partial Reconfiguration Design Guidelines

PR Design Step Guideline Reasoning

Designing for partial
reconfiguration

Do not assume initial states in registers.
Ensure that you reset all the registers.

The registers contain undefined values after
reconfiguration.

Reset the registers that drive control
signals to a known state, after partial
reconfiguration.

Registers contain undefined values after
reconfiguration. In addition, synthesis can
duplicate registers.

continued...   
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PR Design Step Guideline Reasoning

You cannot define synchronous reset as a
global signal for Intel Arria 10 partial
reconfiguration.

PR regions do not support synchronous reset
of registers as a global signal, because the
Intel Arria 10 LAB does not support
synchronous clear (sclr) signal on a global
buffer. The LAB supports the asynchronous
clear (aclr) signal driven from a local input,
or from a global network row clock. As a
result, only the aclr can be a global signal,
feeding registers in a PR region.

Partitioning the design Register all the inputs and outputs for
your PR region.

Improves timing closure and time budgeting.

Reduce the number of signals interfacing
the PR region with the static region in
your design.

Reduces the wire LUT count.

Create a wrapper for your PR region. The wrapper creates common footprint to
static region.

Drive all the PR region output ports to
inactive state.

Prevents the static region logic from
receiving random data during the partial
reconfiguration operation.

PR boundary I/O interface must be a
superset of all the PR persona I/O
interfaces.

Ensures that each PR partition implements
the same ports.

Preparing for partial
reconfiguration

Complete all pending transactions. Ensures that the static region is not in a wait
state.

Maintaining a partially
working system during partial
reconfiguration

Hold all outputs to known constant values. Ensures that the undefined values the PR
region receives during and after the
reconfiguration do not affect the PR control
logic.

Initializing after partial
reconfiguration

Initialize after reset. Retrieves state from memory or other device
resources.

Debugging the design using
Signal Tap Logic Analyzer

• Do not tap signals in the default
personas.

• Store all the tapped signals from a
persona in one .stp file.

The current version of the Intel Quartus
Prime software supports only one .stp
(Signal Tap file) per revision. This limitation
requires you to select partitions, one at a
time, to tap.

Do not tap across regions in the
same .stp file.

Ensures consistent interface (boundary)
across all personas.

Tap only the pre-synthesis signals. In the
Node Finder, filter for Signal Tap: pre-
synthesis.

Ensures that the signal tapping of PR
personas start from synthesis.

1.5.2. Evaluating PR Region Initial Conditions

Unintended initial conditions in a PR region can lead to errors during partial
reconfiguration. Your design may include unintended initial conditions, especially if you
port a design not originally intended for partial reconfiguration. The Intel Quartus
Prime Pro Edition software reports any initial conditions in the PR partitions for your
evaluation following synthesis.

After running synthesis on an implementation partition, you can view the Registers
with Explicit Power-Up Settings report for the partition to identify, locate, and correct
any unintended initial conditions. The Messages window also generates a warning or
error message about any initial conditions during synthesis processing. After
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evaluating the initial condition, you can determine whether the condition is correct for
design functionality, or change the design to remove dependence on an initial
condition that is incompatible with partial reconfiguration.

Figure 6. Registers with Explicit Power-Up Settings Report

1.5.3. Creating Wrapper Logic for PR Regions

If all personas for your design do not have identical top-level interfaces, you must
create the wrapper logic to ensure that all the personas appear similar to the static
region. Define a wrapper for each persona, and instantiate the persona logic within the
wrapper. If all personas have identical top-level interfaces, the personas do not require
wrapper logic. In this wrapper, you can create dummy ports to ensure that all the
personas of a PR region have the same connection to the static region.

During the PR compilation, the Compiler converts each of the non-global ports on
interfaces of the PR region into boundary port wire LUTS. The naming convention for
boundary port wire LUTs are <input_port>~IPORT for input ports, and
<output_port>~OPORT for output ports. For example, the instance name of the wire
LUT for an input port with the name my_input, on a PR region with the name
my_region, is my_region|my_input~IPORT.

1. Manually floorplan the boundary ports using the Logic Lock region assignments, or
place the boundary ports automatically using the Fitter. The Fitter places the
boundary ports during the base revision compile. The boundary LUTs are invariant
locations the Fitter derives from the persona you compile. These LUTs represent
the boundaries between the static region and the PR routing and logic. The
placement remains stationary regardless of the underlying persona, because the
routing from the static logic does not vary with a different persona
implementation.

2. To constrain all boundary ports within a given region, use a wildcard assignment.
For example:

set_instance_assignment -name PLACE_REGION "65 59 65 85" -to \
     u_my_top|design_inst|pr_inst|pr_inputs.data_in*~IPORT

This assignment constrains all the wire LUTS corresponding to the IPORTS that
you specify within the place region, between the coordinates (65 59) and (65 85).

1. Creating a Partial Reconfiguration Design
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Figure 7. Wire-LUTs at the PR Region Boundary

 PR Region Static Region

Optionally, floorplan the boundary ports down to the LAB level, or individual LUT
level. To floorplan to the LAB level, create a 1x1 Logic Lock PLACE_REGION
constraint (single LAB tall and a single LAB wide). Optionally, specify a range
constraint by creating a Logic Lock placement region that spans the range. For
more information about floorplan assignments, refer to Floorplan the Partial
Reconfiguration Design.

Related Information

Step 3: Floorplan the Design on page 23
For more information on floorplanning your design.

1.5.4. Creating Freeze Logic for PR Regions

When partially reconfiguring a design, freeze all the outputs of each PR region to a
known constant value. This freezing prevents the signal receivers in the static region
from receiving undefined signals during the partial reconfiguration process.

The PR region cannot drive valid data until the partial reconfiguration process is
complete, and the PR region is reset. Freezing is important for control signals that you
drive from the PR region.

The freeze technique that you choose is optional, depending on the particular
characteristics of your design. The freeze logic must reside in the static region of your
design. A common freeze technique is to instantiate 2-to-1 multiplexers on each
output of the PR region, to hold the output constant during partial reconfiguration.

Figure 8. Freeze Technique #1 for Intel Arria 10 Devices

PR Logic

Known
  Value

0

1Inputs

Freeze

Outputs

Static Region

An alternative freeze technique is to register all outputs of the PR region in the static
region. Then, use an enable signal to hold the output of these registers constant
during partial reconfiguration.
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Figure 9. Freeze Technique #2 for Intel Arria 10 Devices
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The Partial Reconfiguration Region Controller IP core includes a freeze port for the
region that it controls. Include this IP component with your system-level control logic
to freeze the PR region output. For designs with multiple PR regions, instantiate one
PR Region Controller IP core for each PR region in the design. The Intel Quartus Prime
software includes the Avalon-MM Freeze Bridge and Avalon-ST Freeze Bridge Intel
FPGA IP cores. You can use these IP cores to implement freeze logic, or design your
own freeze logic.

The static region logic must be independent of all the outputs from the PR regions for
a continuous operation. Control the outputs of the PR regions by adding the
appropriate freeze logic for your design.

Note: There is no requirement to freeze the global and non-global inputs of a PR region for
Intel Arria 10 or Intel Stratix 10 devices.

Related Information

• Avalon-ST Partial Reconfiguration Freeze Bridge Intel FPGA IP on page 93

• Avalon-MM Partial Reconfiguration Freeze Bridge Intel FPGA IP on page 84

1.5.5. Resetting the PR Region Registers

Upon partial reconfiguration of a PR region, the status of the PR region registers
become indeterminate. Bring the registers in the PR region to a known state by
applying a reset sequence for the PR region. This reset ensures that the system
behaves to your specifications. Simply reset the control path of the PR region, if the
datapath eventually flushes out within a finite number of cycles.

Table 3. Supported PR Reset Implementation Guideline

PR Reset Type Active-High
Synchronous Reset

Active-High
Asynchronous Reset

Active-Low
Synchronous Reset

Active-Low
Asynchronous Reset

On local signal Yes Yes Yes Yes

On global signal • No (Intel Arria 10)
• Yes (Intel Stratix

10)

Yes • No (Intel Arria 10)
• Yes (Intel Stratix

10)

Yes
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Note: Use active-high local reset instead of active-low, wherever applicable. This technique
allows you to automatically hold the PR region in reset, by virtue of the boundary port
wire LUT.

1.5.6. Promoting Global Signals in a PR Region

In non-PR designs, the Intel Quartus Prime software automatically promotes high fan-
out signals onto dedicated global networks. The global promotion occurs in the Plan
stage of design compilation.

In PR designs, the Compiler disables global promotion for signals originating within the
logic of a PR region. Instantiate the clock control blocks only in the static region,
because the clock floorplan and the clock buffers must be a part of the static region of
the design. Manually instantiating a clock control block in a PR region, or assigning a
signal in a PR region with the GLOBAL_SIGNAL assignment, results in compilation
error. To drive a signal originating from the PR region onto a global network:

1. Expose the signal from the PR region.

2. Drive the signal onto the global network from the static region

3. Drive the signal back into the PR region.

You can drive a maximum of 33 clocks (for Intel Arria 10 devices) or 32 clocks (for
Intel Stratix 10 devices) into any PR region, but you cannot share a row clock
between two PR regions. Use the Chip Planner to visualize the row clock region
boundaries, and to ensure that no two PR regions share a row clock region.

When promoting global signals, the Compiler allows only certain signals to be
global inside the PR regions. Use only global signals to route certain secondary
signals into a PR region. The following table lists the restriction for each block:

Table 4. Supported Signal Types for Driving Clock Networks in a PR Region

Block Type Supported Global Network Signals

LAB, MLAB Clock, ACLR, SCLR(1)

RAM, ROM (M20K) Clock, ACLR, Write Enable (WE), Read Enable (RE), SCLR

DSP Clock, ACLR, SCLR

1.5.7. Implementing Clock Enable for On-Chip Memories with Initialized
Contents

Follow these guidelines to implement clock enable for on-chip memories with
initialized contents:

(1) Only Intel Stratix 10 designs support global SCLR.
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1. To avoid spurious writes during PR programming for memories with initialized
contents, implement the clock enable circuit in the same PR region as the M20K or
MLAB RAM. This circuit depends on an active-high clear signal from the static
region.

2. Before you begin the PR programming, assert this signal to disable the memory’s
clock enable. Your system PR controller must deassert the clear signal on PR
programming completion. You can use the freeze signal for this purpose.

3. Use the Intel Quartus Prime IP Catalog or Platform Designer to instantiate the On-
Chip Memory and RAM Intel FPGA IP cores that include an option to automatically
add this circuitry.

Figure 10. RAM Clock Enable Circuit for PR Region
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Example 1. Verilog RTL for Clock Enable

   reg ce_reg;
    reg [1:0] ce_delay;

    always @(posedge clock, posedge freeze) begin
        if (freeze) begin
            ce_delay <= 2'b0;
        end
        else begin
            ce_delay <= {ce_delay[0], 1'b1};
        end
    end

    always @(posedge clock, negedge ce_delay[1]) begin
        if (~ce_delay[1]) begin
            ce_reg <= 1'b0;
        end
        else begin
            ce_reg <= clken_in;
        end
    end

    wire ram_wrclocken;
    assign ram_wrclocken = ce_reg;
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Example 2. VHDL RTL for Clock Enable

ENTITY mem_enable_vhd IS PORT(
        clock      : in  std_logic;
        freeze  : in  std_logic;
        clken_in : in std_logic;
        ram_wrclocken : out std_logic);
END mem_enable_vhd;

ARCHITECTURE behave OF mem_enable_vhd is
    SIGNAL ce_reg: std_logic;
    SIGNAL ce_delay: std_logic_vector(1 downto 0);
BEGIN
PROCESS (clock, freeze)
BEGIN
    IF ((clock'EVENT AND clock = '1') or (freeze'EVENT AND freeze = '1')) THEN
        IF (freeze = '1') THEN
            ce_delay <= "00";
        ELSE
            ce_delay <= ce_delay(0) & '1';
        END IF;
    END IF;
    
END PROCESS;

PROCESS (clock, ce_delay(1))
BEGIN
    IF ((clock'EVENT AND clock = '1') or (ce_delay(1)'EVENT AND ce_delay(1) = 
'0')) THEN
        IF (ce_delay(1) = '0') THEN
            ce_reg <= '0';
        ELSE
            ce_reg <= clken_in;
        END IF;
    END IF;
    
END PROCESS;

ram_wrclocken <= ce_reg;

END ARCHITECTURE behave;

Related Information

Embedded Memory User Guide

1.5.7.1. Clock Gating

An alternate method to avoid spurious writes of initialized content memories is to gate
the clock feeding the memories in the static region of your design. Clock gating is
logically equivalent to using clock enable on the memories. This method provides the
following features:

• Uses the enable port of the global clock buffers to disable the clock before starting
the partial reconfiguration operation. Also enables the clock on PR completion.

• Ensures that the clock does not switch during reconfiguration, and requires no
additional logic to avoid spurious writes.
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Figure 11. Global Clock Control Block
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1.6. Partial Reconfiguration Design Flow

The PR design flow requires initial planning. This planning involves setting up one or
more design partitions, and then determining the placement assignments in the
floorplan. Well-planned PR partitions improve design area utilization and performance.
The Intel Quartus Prime software also allows you to create nested PR regions as part
of an HPR flow. Reprogramming a child PR region does not affect the parent or the
static region. In the HPR flow, reprogramming the parent region, reprograms the
associated child region with the default child persona, without affecting the static
region. The HPR flow does not impose any restrictions on the number of sub-partitions
you can create in your design.

The PR design flow uses the project revisions feature in the Intel Quartus Prime
software. Your initial design is the base revision, where you define the static region
boundaries and reconfigurable regions on the FPGA. From the base revision, you
create multiple revisions. These revisions contain the different implementations for the
PR regions. However, all PR implementation revisions use the same top-level
placement and routing results from the base revision.
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Figure 12. Partial Reconfiguration Design Flow
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1.6.1. Step 1: Identify Partial Reconfiguration Resources

When designing for partial reconfiguration, you must first determine the logical
hierarchy boundaries that you can define as reconfigurable partitions. Next, set up the
design hierarchy and source code to support this partitioning.

Reconfigurable partitions can contain only core resources, such as LABs, embedded
memory blocks (M20Ks and MLABs), and DSP blocks in the FPGA. All periphery
resources, such as transceivers, external memory interfaces, GPIOs, I/O receivers,
and hard processor system (HPS), must be in the static portion of the design. Partial
reconfiguration of global network buffers for clocks and resets is not possible.
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Table 5. Supported Reconfiguration Methods in Intel Arria 10 and Intel Stratix 10
Devices

Hardware Resource Block Reconfiguration Method

Logic Block Partial reconfiguration

Digital Signal Processing Partial reconfiguration

Memory Block Partial reconfiguration

Core Routing Partial reconfiguration

Transceivers Dynamic reconfiguration

PLL Dynamic reconfiguration

I/O Blocks Not supported

Clock Control Blocks Not supported

Figure 13. Available Resource Types in Intel Arria 10 Devices
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Use any Intel Quartus Prime-supported design entry method to create core-only logic
for a PR partition, including Platform Designer, the Intel HLS Compiler, or standard
SystemVerilog, Verilog HDL, and VHDL design files.

The following Intel FPGA IP cores support system-level debugging in the static region:

• In-System Memory Content Editor

• In-System Sources and Probes Editor

• Virtual JTAG

• Nios II JTAG Debug Module

• Signal Tap Logic Analyzer
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Note: Only Signal Tap Logic Analyzer allows simultaneous debugging of the static and PR
regions.

1.6.2. Step 2: Create Design Partitions

Create design partitions for each PR region that you want to partially reconfigure. You
can create any number of independent partitions or PR regions in your design. Create
design partitions for partial reconfiguration from the Project Navigator, or the Design
Partitions Window.

A design partition is the logical partitioning of the design, and does not specify a
physical area on the device. You associate the partition with a specific area of the
FPGA using Logic Lock Region floorplan assignments. To avoid partitions obstructing
design optimization, group the logic together within the same partition. If your design
includes a hierarchical PR flow with parent and child partitions, you can assign multiple
parent or child partitions to your design, as well as multiple levels of PR partitions.

When you create a Reconfigurable partition, the Compiler preserves post-synthesis
results for the partition and reuses the post-synthesis netlist, if available from
previous compilation, and if you make no partition changes requiring re-synthesis.
Otherwise, the Compiler resynthesizes the partition from the source files. The
Compiler adds wire LUTs for each interface of a Reconfigurable partition, and
performs additional checks for PR compatibility. This setting is incompatible with the
Periphery Reuse Core setting for another partition in the same project revision.

Follow these steps to create and modify design partitions:

1. To elaborate the design, click Processing ➤ Start ➤ Start Analysis &
Elaboration. You must run elaboration before creating partitions.

2. In the Project Navigator, right-click an instance in the Hierarchy tab, click Design
Partition ➤ Set as Design Partition. A design partition icon appears next to
each partition you create.
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3. To view and edit all design partitions in the project, click Assignments ➤ Design
Partitions Window.

4. Specify the appropriate settings for the partition in the Design Partitions Window:

Table 6. Design Partition Settings

Option Description

Partition Name Specifies the partition name. Each partition name in the project must be unique and consist of
only alphanumeric characters. The Intel Quartus Prime software automatically creates a top-
level (|) "root_partition" for each project revision.

Hierarchy Path Specifies the hierarchy path of the entity instance that you assign to the partition. You specify
this value in the Create New Partition dialog box. Double-click <<new>> in the Design
Partitions Window to open the Create New Partition dialog box. The root partition hierarchy
path is |.

Type Double-click to specify one of the following partition types that control how the Compiler
processes and implements the partition:
• Default—Identifies a standard partition. The Compiler processes the partition using the

associated design source files. Select this option when defining a core partition for export.
• Reconfigurable—Identifies a reconfigurable partition in a Partial Reconfiguration flow.

Specify the Reconfigurable type to preserve synthesis results, while allowing refit of the
partition in the PR flow.

• Periphery Reuse Core—Identifies a partition in a block-based design flow that is
reserved for core development when reusing the device periphery (that is, the root
partition).

Preservation Level Specifies one of the following preservation levels for the partition:
• Not Set—specifies no preservation level. The partition compiles from source files.
• synthesized—the partition compiles using the synthesized snapshot.
• final—the partition compiles using the final snapshot.

Empty Specifies an empty partition that the Compiler skips. This setting is incompatible with the
Periphery Reuse Core and Partition Database File settings for the same partition. The
Preservation Level must be Not Set. An empty partition cannot have any child partitions.

continued...   
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Option Description

Partition Database File Specifies a Partition Database File (.qdb) that the Compiler uses during compilation of the
partition. You export the .qdb for the stage of compilation that you want to reuse
(synthesized, placed, or final). Assign the .qdb to a partition to reuse those results in another
context.

Entity Re-binding Specifies (binds) the entity name for the PR partition you are changing in the current
implementation revision. This setting specifies the entity that replaces the default persona in
each implementation revision in the PR flow. This is the only partition setting available for the
root partition.

Color Specifies the color coding of the partition in the Chip Planner and Design Partition Planner
displays.

Figure 14. Design Partitions Window

1.6.3. Step 3: Floorplan the Design

Use Logic Lock floorplan constraints in your PR design to physically partition the
device. Each PR partition in your design must have a corresponding, exclusive physical
partition. You create Logic Lock regions to define the physical partition for your PR
region. This partitioning ensures that the resources available to the PR region are the
same for any persona that you implement.

Your PR region must include only core logic, such as LABs, RAMs, ROMs, and DSPs in a
PR region. Intel Stratix 10 designs can also include Hyper-Registers in the PR
partition. Instantiate all periphery design elements, such as transceivers, external
memory interfaces, and clock networks in the static region of the design. The Logic
Lock regions you create can cross periphery locations, such as the I/O columns and
the HPS, because the constraint is core-only. The following figure shows the PR region
floorplan covering the I/O columns in the middle of the device:
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Figure 15. PR Region Floorplan

Logic Lock Region (Fabric) 
Available to the PR Region

There are two region types:

• Place regions—use these regions to constrain logic to a specific area of the
device. The Fitter places the logic in the region you specify. The Fitter can also
place other logic in the region unless you designate the region as Reserved.

• Route regions—use these regions to constrain routing to a specific area. The
routing region must fully enclose the placement region. Additionally, the routing
regions for the PR regions cannot overlap.
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Figure 16. Floorplanning your PR Design
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Follow these guidelines when floorplanning your PR design:

• Complete the periphery and clock floorplan before core floorplanning. You can use
Interface Planner (Tools ➤ Interface Planner) to create periphery floorplan
assignments for your design.

• Define a routing region that is at least 1 unit larger than the placement region in
all directions.

• Do not overlap the routing regions of multiple PR regions.

• Select the PR region row-wise for least bitstream overhead. In Intel Arria 10
devices, the short, wide regions have smaller bitstream size than tall, narrow
regions. Intel Stratix 10 configuration occurs on sectors. For the least bitstream
overhead, ensure that you align the PR region to sectors.

• For Intel Arria 10 devices, the height of your floorplan affects the reconfiguration
time. A floorplan larger in the Y direction takes longer to reconfigure. This
condition does not apply to Intel Stratix 10 devices because they configure
according to sectors.

• Define sub Logic Lock regions within PR regions to improve timing closure.

• If your design includes HPR parent and child partitions, placement region of the
parent region must fully enclose the routing and placement region of its child
region. Also, the parent wire LUTs must be in an area, outside the child PR region.
This requirement is because the child PR region is exclusive to all other logic,
which includes the parent and the static region.

Related Information

• Analyzing and Optimizing the Design Floorplan

• Interface Planner

1.6.3.1. Applying Floorplan Constraints Incrementally

PR implementation requires additional constraints that identify the reconfigurable
partitions of the design and device. These constraints significantly impact the
Compiler's timing closure ability. You can avoid and more easily correct timing closure
issues by incrementally implementing each constraint, running the Compiler, then
verifying timing closure.
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Note: PR designs require a more constrained floorplan, compared to a flat design. The
overall density and performance of a PR design may be lower than an equivalent flat
design.

The following steps describe incrementally developing the requirements for your PR
design:

1. Implement the base revision using the most complex persona for each PR
partition. This initial implementation must include the complete design with all
periphery constraints, and top-level .sdc timing constraints. Do not include any
Logic Lock region constraints for the PR regions with this implementation.

2. Create partitions by setting the region Type option to Default in the Design
Partitions Window, for all the PR partitions.

3. Register the boundaries of each partition to ensure adequate timing margin.

4. Verify successful timing closure using the Timing Analyzer.

5. Ensure that all the desired signals are driven on global networks. Disable the Auto
Global Clock option in the Fitter (Assignments ➤ Settings ➤ Compiler
Settings ➤ Advanced Settings (Fitter)), to avoid promoting non-global signals.

6. Create Logic Lock core-only placement regions for each of the partitions.

7. Recompile the base revision with the Logic Lock constraints, and then verify timing
closure.

8. Enable the Reserved option for each Logic Lock region to ensure the exclusive
placement of the PR partitions within the placement regions. Enabling the
Reserved option avoids placing the static region logic in the placement region of
the PR partition.

9. Recompile the base revision with the Reserved constraint, and then verify timing
closure.

10. In the Design Partitions Window, specify the Type for each of the PR partitions as
Reconfigurable. This assignment ensures that the Compiler adds wire LUTs for
each interface of the PR partition, and performs additional compilation checks for
partial reconfiguration.

11. Recompile the base revision with the Reconfigurable constraint, and then verify
timing closure. You can now export the top-level partition for reuse in the PR
implementation compilation of the different personas.

1.6.4. Step 4: Add the Partial Reconfiguration Controller Intel FPGA IP

Depending on the target device family, you can add the Partial Reconfiguration
Controller Intel Arria 10 FPGA IP or the Partial Reconfiguration Controller Intel Stratix
10 FPGA IP to you design to send the partial reconfiguration bitstream in an internal
host configuration.

1.6.4.1. Adding the Partial Reconfiguration Controller Intel Stratix 10 FPGA IP

You can customize and instantiate the Partial Reconfiguration Controller Intel Stratix
10 FPGA IP from the IP Catalog (Tools ➤ IP Catalog). The Partial Reconfiguration
Controller Intel Stratix 10 FPGA IP interfaces with the Intel Stratix 10 Secure Device
Manager (SDM) to manage the bitstream source. The SDM performs authentication,
decryption, and decompression on the configuration data. You can use this IP core in
an Intel Stratix 10 design when performing partial reconfiguration with an internal PR
host, Nios II processor, PCI Express, or Ethernet interface.
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Figure 17. Intel Stratix 10 Partial Reconfiguration Controller
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The Intel Quartus Prime software supports PR over the core interface using the Intel
Stratix 10 PR Controller IP core, or PR over the JTAG device pins. PR over JTAG does
not require instantiation of the Partial Reconfiguration Controller Intel Stratix 10 FPGA
IP.

Related Information

Partial Reconfiguration Controller Intel Stratix 10 FPGA IP on page 52

1.6.4.2. Adding the Partial Reconfiguration Controller Intel Arria 10 FPGA IP

The Partial Reconfiguration Controller Intel Arria 10 FPGA IP interfaces with the Intel
Arria 10 PR control block to manage the bitstream source. Use this IP core in Intel
Arria 10 designs when performing partial reconfiguration with an internal PR host, Nios
II processor, PCI Express, or Ethernet interface.

Figure 18. Partial Reconfiguration Controller Intel Arria 10 FPGA IP
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During partial reconfiguration, you send a PR bitstream stored outside the FPGA to the
PR control block inside the FPGA. This communication enables the control block to
update the CRAM bits necessary for reconfiguring the PR region in the FPGA. The PR
bitstream contains the instructions (opcodes) and the configuration bits necessary for
reconfiguring a specific PR region.
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Instantiate the IP core from the Intel Quartus Prime IP Catalog (Tools ➤ IP Catalog)
to automatically connect the IP to the Intel Arria 10 PR control block.

If you create your own custom logic to perform the function of the IP core, manually
instantiate the control block to communicate with the FPGA system.

Related Information

• Partial Reconfiguration Controller Intel Arria 10 FPGA IP on page 57

• PR Control Block and CRC Block Verilog HDL Manual Instantiation on page 66

• PR Control Block and CRC Block VHDL Manual Instantiation on page 67

1.6.5. Step 5: Define Personas

Your partial reconfiguration design can have multiple PR partitions, each with multiple
personas. You define the unique function of each persona in separate Verilog HDL,
SystemVerilog HDL or VHDL design files in the project directory. All the PR personas
must use the same set of signals to interact with the static region.

Ensure that the signals interacting with the static region are a super-set of all the
signals in all the personas. A PR design requires an identical I/O interface for each
persona in the PR region. If all personal for your design do not have identical
interfaces, you must also create wrapper logic to interface with the static region.

Note: If using the Intel Quartus Prime Text Editor, disable Add file to current project when
saving the files. These persona source files should not be part of the Intel Quartus
Prime project or compilations.

1.6.6. Step 6: Create Revisions for Personas

To compile a partial reconfiguration project, create a base revision for the design, as
well as PR implementation revisions for each of the personas.

To create the PR implementation revisions:

1. Click Project ➤ Revisions.

2. To create a new revision, double-click <<new revision>>.

3. Specify a unique Revision name.

4. Select an existing revision for the Based on revision option.

5. For the Revision type, select Partial Reconfiguration - Base for the base
revision or Partial Reconfiguration - Persona Implementation for an
implementation revision.
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Figure 19. Creating Revisions

6. Click Apply and OK.

The following assignments in the respective revision's .qsf file correspond to
specifying the revision type from the Settings dialog box:

Base Revision Assignment:

set_global_assignment -name REVISION_TYPE PR_BASE

Implementation Revision Assignment:

set_global_assignment -name REVISION_TYPE PR_IMPL
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Figure 20. Partial Reconfiguration Compilation Flow
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1.6.7. Step 7: Compile the Base Revision and Export the Static Region

After defining and floorplanning PR partitions and revisions, you compile the base
revision and export the static region.

Follow these steps to compile and export the base and static region:

1. To specify the current revision, click Project ➤ Revisions, and then select the
base revision as current.

2. For Intel Arria 10 designs, you can optionally add the following assignments to
the .qsf to automatically generate the required PR bitstreams following
compilation. This step is not required for Intel Stratix 10 designs.

set_global_assignment -name GENERATE_PR_RBF_FILE ON
set_global_assignment -name ON_CHIP_BITSTREAM_DECOMPRESSION OFF

3. To compile the base revision, click Processing ➤ Start Compilation.

4. To export the static region, click Project ➤ Export Design Partition, and then
specify options for the partition export:

Option Setting

Partition name Select root_partition.

Partition database file Specify a descriptive file name.

Include entity-bound SDC files Enable to include entity bound .sdc files with the partition
export.

Snapshot Select final snapshot.
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1.6.8. Step 8: Setup PR Implementation Revisions

You must prepare the PR implementation revisions before you can generate the PR
bitstream for device programming. This setup includes adding the static region .qdb
file as the source file for each implementation revision. In addition, you must specify
the corresponding entity of the PR region.

Follow these steps to setup the PR implementation revisions:

1. Set a implementation revision as the Current Revision.

2. To specify the .qdb file as the source for root_partition, click Assignments
➤ Design Partitions Window. Double-click the Partition Database File cell
and specify the appropriate .qdb file.

3. For each PR implementation revision, specify the name of the entity that you want
to partially reconfigure in the Entity Re-binding cell.
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4. To compile the design, click Processing ➤ Start Compilation.

5. Repeat steps 1 through 4 to setup and compile each implementation revision.

1.6.9. Step 9: Program the FPGA Device

The Intel Quartus Prime Pro Edition Assembler generates the PR bitstreams for your
design personas. For Intel Arria 10 designs, you send the bitstreams to the PR control
block. For Intel Stratix 10 designs, you send the PR bitstreams to the SDM. You must
compile the PR project, including the base revision, and at least one implementation
revision, before generating the PR bitstreams.

Note: For Intel Stratix 10 designs, the Assembler generates a configuration .rbf
automatically at the end of compilation. For Intel Arria 10 designs, you can use the
GENERATE_PR_RBF_FILE assignment in the .qsf or the Convert Programming
Files dialog box to convert the Partial-Masked SRAM Object Files (.pmsf) to an .rbf
file, as Generating PR Bitstreams for Intel Arria 10 Designs on page 33 describes.

Example 3. Programming File Generation for a Partial Reconfiguration Design
This example design contains a PR region and the following revisions:

• Base revision with persona A

• PR revision with persona B

• PR revision with persona C

Base
Revision with

Persona A

Revision B

Revision C

pr_region.pmsf
static.msf
base.sof

B.sof 
B.pmsf

C.sof
C.pmsf

Partial  
Reconfiguration 

Design

Table 7. Programming Files for PR Designs

Programming File Description

<rev>.<pr_region>.pmsf Contains the partial-mask bits for the PR region. The .pmsf
file contains all the information for creating PR bitstreams.

continued...   
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Programming File Description

Note: The default file name corresponds to the partition
name.

<rev>.<static_region>.msf Contains the mask bits for the static region.

<rev>.sof Contains configuration information for the entire device.

1.6.9.1. Generating PR Bitstreams for Intel Arria 10 Designs

For Intel Arria 10 designs, use either of the following methods to process the PR
bitstreams and generate the Raw Binary File (.rbf) file for reconfiguration. For Intel
Stratix 10 designs, the Assembler generates a configuration .rbf automatically at the
end of compilation.

Generating PR Bitstreams During Compilation

Follow these steps to generate the .rbf file during compilation:

1. Add the following assignments to the revision .qsf to automatically generate the
required PR bitstreams following compilation:

set_global_assignment -name GENERATE_PR_RBF_FILE ON
set_global_assignment -name ON_CHIP_BITSTREAM_DECOMPRESSION OFF

2. To compile the revision and generate the .rbf, click Processing ➤ Start
Compilation.

Generating PR Bitstreams with Convert Programming Files Dialog Box

Follow these steps to generate the .rbf with the Convert Programming Files dialog
box:

Figure 21. Generating PR Bitstreams with Convert Programming Files Dialog

a.rbfa.pmsf b.rbfb.pmsf c.rbfc.pmsf

1. Click File ➤ Convert Programming Files. The Convert Programming Files
dialog box appears.

2. Specify the output file name and Programming file type as Raw Binary File
for Partial Reconfiguration (.rbf).

3. To add the input .pmsf file to convert, click Add File.

4. Select the newly added .pmsf file, and click Properties.

5. Enable or disable any of the following options:
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• Compression—enables compression on PR bitstream.

• Enhanced compression—enables enhanced compression on PR bitstream.

• Generate encrypted bitstream—generates encrypted independent
bitstreams for base image and PR image. You can encrypt the PR image even
if your base image has no encryption. The PR image can have a separate
encryption key file (.ekp). If you enable the Generate encrypted bitstream
option, enable or disable the Enable volatile security key, Use encryption
lock file, and Generate key programming file options.

Figure 22. PMSF File Properties Bitstream Encryption

Note: Enabling the Generate encrypted bitstream option automatically
disables Compression and Enhanced compression. Conversely,
enabling Compression or Enhanced compression automatically
disables Generate encrypted bitstream. You cannot use compression
and encryption at the same time. Enabling the Use encryption lock
file option requires that you import the encryption lock (.qlk) file
generated from the base image.

1.6.9.2. Raw Binary Programming File Byte Sequence Transmission Examples

The raw binary programming file (.rbf) file contains the device configuration data in
little-endian raw binary format. The following example shows transmitting the .rbf
byte sequence 02 1B EE 01 in x32 mode:
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Table 8. Writing to the PR control block or SDM in x32 mode
In x32 mode, the first byte in the file is the least significant byte of the configuration double word, and the
fourth byte is the most significant byte.

Double Word = 01EE1B02

LSB: BYTE0 = 02 BYTE1 = 1B BYTE2 = EE MSB: BYTE3 = 01

D[7..0] D[15..8] D[23..16] D[31..24]

0000 0010 0001 1011 1110 1110 0000 0001

1.6.9.3. Generating a Merged .pmsf File from Multiple .pmsf Files

Use a single merged .rbf file to reconfigure two PR regions simultaneously. To merge
two or more .pmsf files:

1. Open the Convert Programming Files dialog box.

2. Specify the output file name and programming file type as Merged Partial-Mask
SRAM Object File (.pmsf).

3. In the Input files to convert dialog box, select PMSF Data.

4. To add input files, click Add File. You must specify two or more files for merging.

5. To generate the merged file, click Generate.

Alternatively, to merge two or more .pmsf files from the Intel Quartus Prime shell,
type the following command:

quartus_cpf --merge_pmsf=<number of merged files> <pmsf_input_file_1> \ 
     <pmsf_input_file_2> <pmsf_input_file_etc> <pmsf_output_file>

For example, to merge two .pmsf files, type the following command:

quartus_cpf --merge_pmsf=<2> <pmsf_input_file_1> <pmsf_input_file_2> \
     <pmsf_output_file>

1.7. Hierarchical Partial Reconfiguration

Hierarchical partial reconfiguration (HPR) is an extension of partial reconfiguration
(PR), where you contain one PR region within another PR region. You can create
multiple personas for both the child and parent partitions. You nest the child partitions
within their parent partitions. Reconfiguring a parent partition does not impact the
operation in the static region, but replaces the child partitions of the parent region
with default child partition personas.

The HPR design flow includes the following steps:

1. Create a base revision for the design and export the static region, as Step 7:
Compile the Base Revision and Export the Static Region on page 30 describes.

2. Create the implementation revision for each persona, as Step 8: Setup PR
Implementation Revisions on page 31 describes, and export the parent partitions.

3. Specify the .qdb file partition for the static and parent regions.

4. Specify the corresponding entity for the parent or child.

When compiling the implementation revision for an HPR design, you must fully
floorplan the child partition, similar to planning the PR region of a base revision.
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Related Information

AN826: Hierarchical Partial Reconfiguration Tutorial for Intel Stratix 10 GX FPGA
Development Board

for step-by-step HPR instructions

1.8. Partial Reconfiguration Design Timing Analysis

The interface between partial and static partitions remains the same for each PR
implementation revision. Perform timing analysis on each PR implementation revision
to ensure that there are no timing violations. To ensure timing closure of a design with
multiple PR regions, you can create aggregate revisions for all possible PR region
combinations for timing analysis.

Note: Logic Lock regions impose placement constraints that affect the performance and
resource utilization of your PR design. Ensure that the design has additional timing
allowance and available device resources. Selecting the largest and most timing-
critical persona as your base persona optimizes the timing closure.

Related Information

The Intel Quartus Prime Timing Analyzer

1.8.1. Running Timing Analysis on Aggregate Revisions

To ensure timing closure of a design with multiple PR regions, you create aggregate
revisions for all possible PR region combinations and rum timing analysis.

1. To open the Revisions dialog box, click Project ➤ Revisions.

2. To create a new revision, double-click <<new revision>>.

3. Specify the Revision name and select the base revision for Based on Revision.

4. To export the post-fit database from the base compile (static partition), type the
following command in the Intel Quartus Prime shell:

quartus_cdb <project name> <base revision> --export_block \
     "root_partition" --snapshot final --file \
     "<base revision name>.qdb"

Note: Ensure that you include all the .sdc and .ip files for the static and PR
regions. To detect the clocks, ensure that the .sdc file for the PR Controller
IP follows the entry of any .sdc file that creates the clocks that the IP core
uses. You facilitate this order by ensuring the .ip file for the PR Controller
IP comes after any .ip or .sdc files that you use to create these clocks in
the .qsf file for the project revision. Refer to Partial Reconfiguration
Solutions IP User Guide on page 49 for more information.

5. To export the post-fit database from multiple personas (for the PR implementation
revisions), type the following commands in the Intel Quartus Prime shell:

quartus_cdb <project name> -c <PR1 revision> --export_block \
     <PR1 Partition name> --snapshot final --file "pr1.qdb"
quartus_cdb <project name> -c <PR2 revision> --export_block \
     <PR2 Partition name> --snapshot final --file "pr2.qdb"
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6. To import the post-fit databases of the static region as an aggregate revision, type
the following commands in the Intel Quartus Prime shell:

quartus_cdb <project name> -c <aggr_rev> --import_block \
     "root_partition" --file "<base revision name>.qdb"
quartus_cdb <project name> -c <aggr_rev> --import_block \
     <PR1 partition name> --file "pr1.qdb" 
quartus_cdb <project name> -c <aggr_rev> --import_block \
     <PR2 Partition name> --file "pr2.qdb"

7. To integrate post-fit database of all the partitions, type the following command in
the Intel Quartus Prime shell:

quartus_fit <project name> -c <aggr_rev>

Note: The Fitter verifies the legality of the post-fit database, and combines the
netlist for timing analysis. The Fitter does not reroute the design.

8. To perform timing analysis on the aggregate revision, type the following command
in the Intel Quartus Prime shell:

quartus_sta <proj name> -c <aggr_rev>

9. Run timing analysis on aggregate revision for all possible PR persona
combinations. If a specific persona fails timing closure, recompile the persona and
perform timing analysis again.

1.9. Partial Reconfiguration Design Simulation

Simulation verifies the behavior of your design before device programming. The Intel
Quartus Prime Pro Edition software supports simulating the delivery of a partial
reconfiguration bitstream to the PR control block. This simulation allows you to
observe the resulting change and the intermediate effect in a reconfigurable partition.

The Intel Quartus Prime Pro Edition software supports simulation of PR persona
transitions through use of simulation multiplexers. You use the simulation multiplexers
to change which persona drives logic inside the PR region during simulation. This
simulation allows you to observe the resulting change and the intermediate effect in a
reconfigurable partition.

Similar to non-PR design simulations, preparing for a PR simulation involves setting up
your simulator working environment, compiling simulation model libraries, and
running your simulation. The Intel Quartus Prime software provides simulation
components to help simulate a PR design, and can generate the gate-level PR
simulation models for each persona. Use either the behavioral RTL or the gate level PR
simulation model for simulation of the PR personas. The gate-level PR simulation
model allows for accurate simulation of registers in your design, and reset sequence
verification. These technology-mapped registers do not assume initial conditions.

Related Information

• Generating and Simulating Intel FPGA IP on page 99

• Simulating Intel FPGA Designs

1.9.1. Partial Reconfiguration Simulation Flow

At a high-level, a PR operation consists of the following steps:
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1. System-level preparation for a PR event.

2. Retrieval of the partial bitstream from memory.

3. Transmission of the partial bitstream to the Intel Arria 10 PR control block or Intel
Stratix 10 SDM.

4. Resulting change in the design as a new persona becomes active.

5. Post-PR system coordination.

6. Use of the new persona in the system.

You can simulate each of these process steps in isolation, or as a larger sequence
depending on your verification type requirement.

Related Information

• Intel Arria 10 PR Control Block Simulation Model on page 105

• Generating the PR Persona Simulation Model on page 107

1.9.1.1. Simulating PR Persona Replacement

The logical operation of the PR partition changes when a new persona loads during the
partial reconfiguration process. Simulate the replacement of personas using
multiplexers on the input and output of the persona under simulation. Create RTL
wrapper logic to represent the top-level of the persona. The wrapper instantiates the
default persona during compilation. During simulation, the wrapper allows the
replacement of the active persona with another persona. Instantiate each persona as
the behavioral RTL in the PR simulation model the Intel Quartus Prime EDA Netlist
Writer generates. The Intel Quartus Prime software includes simulation modules to
interface with your simulation testbench:

• altera_pr_wrapper_mux_in

• altera_pr_wrapper_mux_out

• altera_pr_persona_if (SystemVerilog interface allows you to connect the
wrapper multiplexers to a testbench driver)
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Figure 23. Simulation of PR Persona Switching
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Example 4. RTL Wrapper for PR Persona Switching Simulation

The pr_activate input of the altera_pr_wrapper_mux_out module enables the
MUX to output X. This functionality allows the simulation of unknown outputs from the
PR persona, and also verifies the normal operation of the design’s freeze logic. The
following code corresponds to the simulation of PR persona switching, shown in the
above figure:

module pr_core_wrapper
(
   input wire a,
   input wire b,
   output wire o
);

localparam ENABLE_PERSONA_1 = 1;
localparam ENABLE_PERSONA_2 = 1;
localparam ENABLE_PERSONA_3 = 1;
localparam NUM_PERSONA = 3;

logic pr_activate;
int persona_select;

altera_pr_persona_if persona_bfm();
assign pr_activate = persona_bfm.pr_activate;
assign persona_select = persona_bfm.persona_select;

wire a_mux [NUM_PERSONA-1:0];
wire b_mux [NUM_PERSONA-1:0];
wire o_mux [NUM_PERSONA-1:0];

generate
   if (ENABLE_PERSONA_1) begin
      localparam persona_id = 0;
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      `ifdef ALTERA_ENABLE_PR_MODEL
         assign u_persona_0.altera_sim_pr_activate = pr_activate;
      `endif

      pr_and u_persona_0
      (
         .a(a_mux[persona_id]),
         .b(b_mux[persona_id]),
         .o(o_mux[persona_id])
      );
   end
endgenerate

generate
   if (ENABLE_PERSONA_2) begin
      localparam persona_id = 1;

      `ifdef ALTERA_ENABLE_PR_MODEL
         assign u_persona_1.altera_sim_pr_activate = pr_activate;
      `endif

      pr_or u_persona_1
      (
         .a(a_mux[persona_id]),
         .b(b_mux[persona_id]),
         .o(o_mux[persona_id])
      );

   end
endgenerate

generate
   if (ENABLE_PERSONA_3) begin
      localparam persona_id = 2;

      `ifdef ALTERA ENABLE PR MODEL
         assign u_persona_2.altera_sim_pr_activate = pr_activate;
      `endif

      pr_empty u_persona_2
      (
         .a(a_mux[persona_id]),
         .b(b_mux[persona_id]),
         .o(o_mux[persona_id])
      );

   end
endgenerate

altera_pr_wrapper_mux_in #(.NUM_PERSONA(NUM_PERSONA), .WIDTH(1)) /
     u_a_mux(.sel(persona_select), .mux_in(a), .mux_out(a_mux));

altera_pr_wrapper_mux_in #(.NUM_PERSONA(NUM_PERSONA), .WIDTH(1)) /
     u_b_mux(.sel(persona_select), .mux_in(b), .mux_out(b_mux));

altera_pr_wrapper_mux_out #(.NUM_PERSONA(NUM_PERSONA), .WIDTH(1)) /
     u_o_mux(.sel(persona_select), .mux_in(o_mux), .mux_out(o), .pr_activate /
     (pr_activate));

endmodule

1.9.1.2. altera_pr_persona_if Module

Instantiate the altera_pr_persona_if SystemVerilog interface in a PR region
simulation wrapper to connect to all the wrapper multiplexers. Optionally, connect
pr_activate to the PR simulation model.
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Connect the interface’s persona_select to the sel port of all input and output
multiplexers. Connect the pr_activate to the pr_activate of all the output
multiplexers. Optionally, connect the report events to the report event ports of the PR
simulation model. Then, the PR region driver testbench component can drive the
interface.

interface altera_pr_persona_if;
   logic pr_activate;
   int   persona_select;
   
   event report_storage_if_x_event;
   event report_storage_if_1_event;
   event report_storage_if_0_event;
   event report_storage_event;
   
   initial begin
      pr_activate <= 1'b0;
   end
endinterface : altera_pr_persona_if

The <QUARTUS_INSTALL_DIR>/eda/sim_lib/altera_lnsim.sv file defines the
altera_pr_persona_if component.

1.9.1.3. altera_pr_wrapper_mux_out Module

The altera_pr_wrapper_mux_out module allows you to multiplex the outputs of all
PR personas to the outputs of the PR region wrapper.

Instantiate one multiplexer per output port. Specify the active persona using the sel
port of the multiplexer. The pr_activate port allows you to drive the multiplexer
output to “x”, to emulate the unknown value of PR region outputs during a PR
operation. Parameterize the component to specify the number of persona inputs, the
multiplexer width, and the MUX output value when pr_activate asserts.

module altera_pr_wrapper_mux_out #(
   parameter NUM_PERSONA = 1,
   parameter WIDTH = 1,
   parameter [0:0] DISABLED_OUTPUT_VAL = 1'bx
) (
   input int sel,
   input wire [WIDTH-1 : 0] mux_in [NUM_PERSONA-1:0],
   output reg [WIDTH-1:0]   mux_out,
   input wire               pr_activate
);
 
   always_comb begin
      if ((sel < NUM_PERSONA) && (!pr_activate))
         mux_out = mux_in[sel];
      else
         mux_out = {WIDTH{DISABLED_OUTPUT_VAL}};
   end
 
endmodule : altera_pr_wrapper_mux_out

The <QUARTUS_INSTALL_DIR>/eda/sim_lib/altera_lnsim.sv file defines the
altera_pr_wrapper_mux_out component.

1.9.1.4. altera_pr_wrapper_mux_in Module

The altera_pr_wrapper_mux_in module allows you to de-multiplex inputs to a PR
partition wrapper for all PR personas.
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Instantiate one multiplexer per input port. Specify the active persona using the sel
port of the multiplexer. Parameterize the component to specify the number of persona
outputs, the multiplexer width, and the MUX output for any disabled output. When
using the altera_pr_wrapper_mux_in to mux a clock input, use the
DISABLED_OUTPUT_VAL of 0, to ensure there are no simulation clock events of the
disabled personas.

module altera_pr_wrapper_mux_in#(
   parameter NUM_PERSONA = 1,
   parameter WIDTH = 1,
   parameter [0:0] DISABLED_OUTPUT_VAL = 1'bx
) (
    
   input int sel,
   input wire [WIDTH-1:0] mux_in,
   output reg [WIDTH-1 : 0] mux_out [NUM_PERSONA-1:0]
);
   always_comb begin
      for (int i = 0; i < NUM_PERSONA; i++)
         if (i == sel)
            mux_out[i] = mux_in;
         else
            mux_out[i] = {WIDTH{DISABLED_OUTPUT_VAL}};
   end
 
    
endmodule : altera_pr_wrapper_mux_in

The <QUARTUS_INSTALL_DIR>/eda/sim_lib/altera_lnsim.sv file defines the
altera_pr_wrapper_mux_in component.

1.10. Partial Reconfiguration Design Debugging

The Signal Tap logic analyzer allows you to debug static or PR regions of a design. If
you just want to debug the static region, you can use the In-System Sources and
Probes Editor, In-System Memory Content Editor, or JTAG Avalon Master Bridge.

Related Information

System Debugging Tools Overview

1.10.1. Debugging PR Designs with Signal Tap Logic Analyzer

You can use the Signal Tap logic analyzer to debug PR designs. You must use a debug
bridge to extend Signal Tap debugging into the PR partition. You can then use Signal
Tap to debug by connecting to the debug bridge. To use the debug bridge, you
instantiate the SLD JTAG Bridge Agent Intel FPGA IP and SLD JTAG Bridge Host pair
for each PR region in your design.

Perform the following steps during the early planning stage, to ensure you can use
Signal Tap to debug your static as well as PR region:

1. Instantiate the SLD JTAG Bridge Agent IP in the static region.

2. Instantiate the SLD JTAG Bridge Host IP in the PR region of the default persona.

3. Instantiate the SLD JTAG Bridge Host IP for each of the personas when creating
revisions for the personas.

The Signal Tap Logic Analyzer uses the hierarchical debug capabilities provided by
Intel Quartus Prime software to tap signals in the static and PR regions
simultaneously.
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You can debug multiple personas present in your PR region, as well as multiple PR
regions. For complete information on the debug infrastructure using hierarchical hubs,
refer to Debugging Partial Reconfiguration Designs Using Signal Tap Logic Analyzer in
the Debug Tools User Guide.

Related Information

• AN 845: Signal Tap Tutorial for Intel Arria 10 Partial Reconfiguration Design

• AN 841: Signal Tap Tutorial for Intel Stratix 10 Partial Reconfiguration Design

• Instantiating the SLD JTAG Bridge Agent

• Instantiating the SLD JTAG Bridge Host

• Debugging Partial Reconfiguration Designs Using Signal Tap Logic Analyzer

1.11. PR Bitstream Compression and Encryption

You can compress and encrypt the base bitstream and the PR bitstream for your PR
project using options available in the Intel Quartus Prime software.

Compress the base and PR programming bitstreams independently, based on your
design requirements. When encrypting only the base image, specify whether or not to
encrypt the PR images. The following guidelines apply to PR bitstream compression
and encryption:

• You can encrypt the base and PR image independently. In addition, you can use
different encryption keys in each case, For example, you can use a non-volatile
encryption key for the base image, and a volatile encryption key for the PR image.

• Refer to Table 9 on page 45 to ensure the correct Clock-to-Data (CD) ratio
setting for encryption or compression.

For partial reconfiguration with the PR Controller IP core, specify enhanced
compression by turning on the Enhanced compression option when specifying the
parameters in the IP Catalog or Platform Designer parameter editors.

Note: You cannot use hardware or enhanced compression together with encryption
simultaneously.

1.11.1. Generating an Encrypted PR Bitstream

To partially reconfigure your Intel Arria 10 device with an encrypted bitstream:

Note: Intel Quartus Prime software does not support bitstream encryption and compression
for Intel Stratix 10 designs.

1. Create a 256-bit key file (.key).

2. To generate the key programming file (.ekp) from the Intel Quartus Prime shell,
type the following command:

quartus_cpf --key <keyfile>:<keyid> /
     <base_sof_file> <output_ekp_file>
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For example:

quartus_cpf --key my_key.key:key1 base.sof key.ekp

3. To generate the encrypted PR bitstream (.rbf), run the following command:

quartus_cpf -c <pr_pmsf_file> <pr_rbf_file>
qcrypt -e --keyfile=<keyfile> --keyname=<keyid> –lockto=/
     <qlk file> --keystore=<battery|OTP> /
     <pr_rbf_file> <pr_encrypted_rbf_file>

• lockto—specifies the encryption lock.

• keystore—specifies the volatile key (battery) or the non-volatile key (OTP).

For example:

quartus_cpf -c top_v1.pr_region.pmsf top_v1.pr_region.rbf /
     qcrypt -e --keyfile=my_key.key --keyname=key1 --keystore=battery /
     top_v1.pr_region.rbf top_v1_encrypted.rbf

4. To program the key file as volatile key (default) into the device, type the following
command:

quartus_pgm -m jtag -o P;<output_ekp_file>

For example:

quartus_pgm -m jtag -o P;key.ekp

5. To program the base image into the device, type the following command:

quartus_pgm -m jtag -o P;<base_sof_file>

For example:

quartus_pgm -m jtag -o P;base.sof

6. To partially reconfigure the device with the encrypted bitstream, type the following
command:

quartus_pgm -m jtag --pr <output_encrypted_rbf_file>

For example:

quartus_pgm -m jtag --pr top_v1_encrypted.rbf

Note: qcrypt generates an error if the Enable bitstream compatibility check parameter
is enabled for an instance of the Partial Reconfiguration Controller Intel Arria 10 FPGA
IP. Use one of the following methods to avoid this error:

• Use the Convert Programming Files dialog box, rather than qcrypt, to
generate the encrypted PR bitstream, as Generating PR Bitstreams for Intel Arria
10 Designs on page 33 describes.

• If you want use qcrypt with Intel Arria 10 designs, regenerate the Partial
Reconfiguration Controller IP without the Enable bitstream compatibility check
option enabled, and with the Enable hierarchical PR support option enabled, as 
Adding the Partial Reconfiguration Controller Intel Arria 10 FPGA IP on page 27
describes. Recompile the design before regenerating the PR bitstream.
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Related Information

Using the Design Security Features in Intel FPGAs

1.11.2. Clock-to-Data Ratio for Bitstream Encryption and Compression

The following table lists the valid combinations of bitstream encryption and
compression. The Clock-to-Data (CD) ratio is defined as the number of clock cycles
that each cycle of data must remain valid before the next clock cycle. For example, a
CD ratio of 4 means that the data must remain valid for 4 clock cycles before the next
cycle. Enhanced decompression uses the same CD ratio as plain bitstreams (that is,
with both encryption and compression off). When enhanced compression is enabled,
always refer to x16 data width. If you use compression and enhanced compression
together, the CD ratio follows the compression bitstream - 4. If you use plain and
enhanced compression together, the CD ratio follows the plain bitstream - 1.

Table 9. Valid Combinations and CD Ratio for Bitstream Encryption and Compression

Configuration Data Width AES Encryption Basic Compression CD Ratio

x8 Off Off 1

Off On 2

On Off 1

x16 Off Off 1

Off On 4

On Off 2

x32 Off Off 1

Off On 8

On Off 4

Use the exact CD ratio that the Valid combinations and CD Ratio for Bitstream
Encryption and Compression table specifies for different bitstream types. The CD ratio
for plain .rbf must be 1. The CD ratio for compressed .rbf must be 2, 4 or 8,
depending on the width. Do not specify the CD ratio as the necessary minimum to
support different bitstream types.

Note: Intel Quartus Prime software does not support both bitstream encryption and
compression for Intel Stratix 10 designs.

1.11.3. Data Compression Comparison

Standard compression results in a 30-45% decrease in .rbf size. Use of the
enhanced data compression algorithm results in 55-75% decrease in .rbf size. The
algorithm increases the compression at the expense of additional core area required to
implement the compression algorithm.
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The following figure shows the compression ratio comparison across PR designs with
varying degrees of Logic Element (LE):

Figure 24. Compression Ratio Comparison between Standard Compression and
Enhanced Compression
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Note: Intel Quartus Prime software does not support both bitstream encryption and
compression for Intel Stratix 10 designs.

1.12. Avoiding PR Programming Errors

You can use the following guidelines to avoid or resolve common PR programming
errors.

Table 10. PR Programming Guidelines

PR Programming Guideline Description

Device in project must match
device on board

Confirm the target FPGA device that you specify for the project matches the device on
the development kit you target. These two devices must be the same. Click
Assignments ➤ Device to view the target device.

Programmer versions must
match

When using the Intel Quartus Prime Programmer for PR programming, confirm that the
Programmer version matches the Intel Quartus Prime version that you use for
compilation. A mismatch between the Programmer and Intel Quartus Prime software
version can occur if you compile on one machine, and then program on a different
machine with a different Intel Quartus Prime version. The software version match is
especially critical for Intel Stratix 10 designs, because the Intel Stratix 10 PR
configuration hardware has dependencies inside the Programmer.

Specify a lower JTAG clock
frequency

Lower the JTAG clock frequency to 6MHz:
1. In the Programmer window, click Hardware Setup, and then select Intel FPGA

Download Cable II as the programming hardware.
2. For the Hardware frequency, specify a value from 24000000 (24MHz) to 6000000

(6MHz).
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PR Programming Guideline Description

Close timing for all revisions Confirm that each project revision closes timing after design compilation:
1. In the Compilation Report, expand the Timing Analyzer ➤ Slow 900mV 100C

Model folders, and then view the Setup Summary, Hold Summary, Recovery
Summary, Removal Summary, and Minimum Pulse Width Summary reports. In each
report, verify that there are no timing violations indicated by a negative Slack
value in the report.

2. Repeat step 1 to verify timing closure in the Slow 900mV 0C Model, the Fast
900mV 100C Model, and the Fast 900mV 0C Model. The design closes timing
when there are no negative Slack values for any clock in the report.

Negative slack indicates 
timing violation

3. Repeat steps 1 and 2 for each project revision in the PR design.

Note: If an error occurs during PR operation for Intel Stratix 10 designs using Single Event
Upset (SEU) detection, the PR region is frozen, becomes non-functional, and SEU
disables for all sectors the PR region covers. The Avalon-ST status interface or the
Avalon-MM register map of the Partial Reconfiguration Controller Intel Stratix 10 FPGA
IP reflects this error status. To resolve this error and restore the SEU detection,
perform another PR operation to reload a valid PR bitstream.
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1.13. Creating a Partial Reconfiguration Design Revision History

Document Version Intel Quartus
Prime Version

Changes

2018.08.07 18.0.0 Reverted document title to Partial Reconfiguration User Guide: Intel
Quartus Prime Pro Edition.

2018.07.18 18.0.0 • Corrected signals in Simulation of PR Persona Switching diagram.

2018.06.18 18.0.0 • Corrected syntax errors and added note in Running Timing Analysis on
Aggregate Revisions.

2018.05.29 18.0.0 • Added description of "|" that identifies the root partition hierarchy path
in Design Partitions Window.

• Clarified .qsf assignment in Running Timing Analysis on Aggregate
Revisions.

2018.05.07 18.0.0 • Added description of new Partial Reconfiguration External Configuration
Controller Intel Stratix 10 FPGA IP.

• Removed descriptions of obsolete synthesis-only revisions and
corresponding personas. Replaced with latest simplified flow
instructions.

• Updated names of Partial Reconfiguration Controller Intel Arria 10 FPGA
IP and Partial Reconfiguration Controller Intel Stratix 10 FPGA IP.

• Added Design Partition Settings topic.
• Added Evaluating PR Partition Initial Conditions topic.
• Added Avoiding PR Programming Errors topic.
• Described qcrypt incompatibility with Enable bitstream compatibility

check and workaround.
• Added as chapter in new Partial Reconfiguration User Guide.
• Updated command-line syntax in Running Timing Analysis on

Aggregate Revisions topic.
• Removed obsolete HPR flow script information and linked to AN826:

Hierarchical Partial Reconfiguration Tutorial for Intel Stratix 10 GX
FPGA Development Board

• Added note about recovery after PR error when using SEU detection in
Intel Stratix 10 designs.

2017.11.06 17.1.0 • Added partial reconfiguration support for Intel Stratix 10 devices.
• Added descriptions of Intel Stratix 10 Partial Reconfiguration Controller

IP, SUPR, HPR, and SDM to terms list.
• Updated for latest Intel branding and software user interface.

2017.05.08 17.0.0 • Added information about Hierarchical Partial Reconfiguration.
• Added new topic Partial Reconfiguration Simulation and Verification.
• Added new topic 'Run Timing Analysis on a Design with Multiple PR

Partitions'.
• Updated Freeze Logic for PR Regions.
• Added new topic Debugging Using Signal Tap Logic Analyzer.
• Other minor updates.

10.31.2016 16.1.0 • Initial release.

Related Information

Altera Documentation Archive
For previous versions of the Intel Quartus Prime Handbook, search the Altera
documentation archives.
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2. Partial Reconfiguration Solutions IP User Guide
The Intel Quartus Prime Pro Edition software includes the following Intel FPGA IP cores
that simplify partial reconfiguration implementation.

Instantiate one or more of these IP cores to implement handshake and freeze logic for
PR functionality in your design. Alternatively, create your own PR handshake and
freeze logic that interfaces with the PR region.

Table 11. Partial Reconfiguration IP Cores

Intel FPGA IP Description Usage

Partial Reconfiguration
Controller Intel Stratix 10 FPGA
IP

Dedicated IP component that sends the partial
reconfiguration bitstream for the Intel Stratix 10 FPGA.
The PR bitstream performs reconfiguration by adjusting
CRAM bits in the FPGA.

One instance per FPGA

Partial Reconfiguration External
Configuration Controller Intel
Stratix 10 FPGA IP

IP component that supports Intel Stratix 10 FPGA partial
reconfiguration via an external source over dedicated PR
pins.

One instance per FPGA
for external
configuration

Partial Reconfiguration
Controller Intel Arria 10 FPGA IP

Dedicated IP component that sends the partial
reconfiguration bitstream to the Intel Arria 10 FPGA. The
PR bitstream performs reconfiguration by adjusting
CRAM bits in the FPGA.

One instance per FPGA,
internal or external
configuration.

Partial Reconfiguration Region
Controller Intel FPGA IP

Provides a standard Avalon Memory Mapped (Avalon-
MM) interface to the block that controls handshaking
with the PR region. Ensures that PR region stops, resets,
and restarts, according to the PR handshake.

One instance per PR
region.

Avalon-MM Partial
Reconfiguration Freeze Bridge
Intel FPGA IP

Provides freeze capabilities to the PR region for Avalon
Avalon-MM interfaces.

One instance for each
interface in each PR
region.

Avalon-ST Partial
Reconfiguration Freeze Bridge
Intel FPGA IP

Provides freeze capabilities to the PR region for Avalon
Streaming (Avalon-ST) interfaces.

One instance for each
interface in each PR
region.

2.1. Internal and External PR Host Configurations

You perform PR with either an internal host residing in the core resources, or with an
external host via dedicated device pins. Use of an internal host stores of all PR host
logic on the FPGA device, rather than on an external device. The PR host interfaces
with the control block through simple handshaking and data transfer.
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Figure 25. Intel Arria 10 Partial Reconfiguration IP Components (Internal Host)
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Figure 26. Intel Stratix 10 Partial Reconfiguration IP Components (Internal Host)
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Figure 27. Partial Reconfiguration with Microcontroller External Host (Intel Arria 10
device)
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Figure 28. Partial Reconfiguration with HPS Internal Host (Intel Arria 10 device)
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Related Information

AN 784: Partial Reconfiguration over PCI Express Reference Design for Intel Arria 10
Devices

2.2. Partial Reconfiguration Controller Intel Stratix 10 FPGA IP

The Partial Reconfiguration Controller Intel Stratix 10 FPGA IP provides partial
reconfiguration functionality for Intel Stratix 10 designs. The IP core provides a
standard interface to the Intel Stratix 10 FPGA secure device manager (SDM), and has
a maximum clock frequency of 250MHz.

Figure 29. Intel Stratix 10 Partial Reconfiguration Controller
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Note: If an error occurs during PR operation for Intel Stratix 10 designs using Single Event
Upset (SEU) detection, the PR region is frozen, becomes non-functional, and SEU
disables for all sectors the PR region covers. The Avalon-ST status interface or the
Avalon-MM register map of the Partial Reconfiguration Controller Intel Stratix 10 FPGA
IP reflects this error status. To resolve this error and restore the SEU detection,
perform another PR operation to reload a valid PR bitstream.

2.2.1. Memory Map: Intel Stratix 10 Partial Reconfiguration Controller

Table 12. Avalon-MM Slave Memory Map

Name Address
Offset

Width Access Description

PR_DATA 0x00 32 Write Every data write to this address indicates this
bitstream is sending to the IP core.
Width is set by the Input data width parameter.

PR_CSR 0x01 32 Read or Write Control and status registers with the following offset
bits:
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Name Address
Offset

Width Access Description

• 31 - 6: Reserved.
• 5: Read/Write for irq signal mask bit. Write 1 to

this bit enable irq signal and 0 to disable the irq
signal.

• 4: Read/Clear for irq signal. The irq signal asserts
if an error occurs. The Master must read the status
signal and clear the interrupt by writing 1 to this bit.

• 3 - 1: Read-only for status signal.
• 0: Read/Write for pr_start signal. To streamline

the flow, the IP core automatically de-asserts to
value 0, one clock cycle after the signal asserts.

PR_SW_VER 0x02 32 Read Read-only SW version register. Register is currently
0xBA500000

Related Information

Avalon Interface Specifications

2.2.2. Parameters: Intel Stratix 10 Partial Reconfiguration Controller

The Intel Stratix 10 Partial Reconfiguration Controller IP core supports customization
of the following parameters.

Table 13. Partial Reconfiguration Controller Intel Stratix 10 FPGA IP Parameter
Settings

Parameter Value Description

Enable Avalon-ST
or Avalon-MM
slave interface

Avalon-ST/
Avalon-MM

Enables the controller's Avalon-ST or Avalon-MM slave interface.

Input data width <bits> Specifies the size of the controller's data conduit interface in bits. The IP
supports device widths of 32 and 64.

Enable interrupt
interface

Yes/No Enables interrupt assertion for detection of incompatible bitstream,
CRC_ERROR, PR_ERROR, or successful partial reconfiguration. Upon
interrupt, query PR_CSR[4:2] for status. Write a 1 to PR_CSR[5] to clear
the interrupt. Use only together with the Avalon-MM slave interface.
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Figure 30. Parameter Editor

2.2.3. Ports: Intel Stratix 10 Partial Reconfiguration Controller

The Partial Reconfiguration Controller Intel Stratix 10 FPGA IP includes the following
interface ports.

Figure 31. Avalon-ST Sink Interface Ports
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Figure 32. Avalon-MM Slave Interface Ports

Table 14. Clock/Reset Ports

Port Name Width Direction Function

reset 1 Input Asynchronous reset for the PR Controller IP core. Resetting
the PR Controller IP core during a partial reconfiguration
operation can cause the device to lock up.

clk 1 Input Input clock to the PR Controller IP core.
The input clock must be free-running. The IP core has a
maximum clock frequency of 250MHz.

Table 15. Avalon-ST Slave interface Ports
These ports are available when you enable the Avalon-ST slave interface.

Port Name Width Direction Function

pr_start 1 Input A signal arriving at this port asserted high initiates
a PR event. You must assert this signal high for a
minimum of one clock cycle, and de-assert it low,
prior to the end of the PR operation.

avst_sink_data[] 32|64 Input Avalon-ST data signal that is synchronous with the
rising edge of the clk signal. The Input data
width parameter specifies this port width.

avst_sink_valid 1 Input Avalon-ST data valid signal that indicates the
avst_sink_data port contains valid data.

avst_sink_ready 1 Output Avalon-ST ready signal that indicates the device is
ready to read the streaming data on the
avst_sink_data port whenever the
avst_sink_valid signal asserts high. Stop
sending valid data when this port is low.

status[2..0] 3 Output A 3-bit error output that indicates the status of a
PR event. Once the outputs latch high as follow,
you can only reset the outputs at the beginning of
the next PR event:
3’b000 – power-up nreset asserted

3’b001 – configuration system is busy

3’b010 – PR operation is in progress

3’b011 – PR operation successful

3’b100 – PR_ERROR is triggered

3’b101 – Reserved
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Port Name Width Direction Function

3'b110 – Reserved

3'b111 – Reserved

Table 16. Avalon-MM Slave Interface Ports
These ports are available when you enable the Avalon-MM slave interface.

Port Name Width Direction Function

avmm_slave_address 4 Input Avalon-MM address bus in the unit of Word
addressing.

avmm_slave_read 1 Input Avalon-MM read control.

avmm_slave_readdata 32 Output Avalon-MM read data bus.

avmm_slave_write 1 Input Avalon-MM write control.

avmm_slave_writedata 32 Input Avalon-MM write data bus.

avmm_slave_waitrequest 1 Output Upon assertion, indicates that the IP is busy and the
IP is unable to respond to a read or write request.

irq 1 Output Interrupt signal when you enable the Enable
interrupt interface parameter.

2.2.4. Timing Specifications: Intel Stratix 10 Partial Reconfiguration
Controller

The following timing diagram illustrates a successful PR operation. The status[2:0]
output signal indicates whether the operations passes or fails. The PR operation
initiates upon assertion of the pr_start signal. Monitor the status[] signal to
detect the end of the PR operation.

Partial Reconfiguration Controller Intel Stratix 10 FPGA IP

Figure 33. Timing Specifications
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2.3. Partial Reconfiguration Controller Intel Arria 10 FPGA IP

The Partial Reconfiguration Controller Intel Arria 10 FPGA IP provides a standard
interface to the partial reconfiguration functionality in the PR control block. Use this IP
core to avoid manually instantiating a PR control block interface. The Partial
Reconfiguration Controller Intel Arria 10 FPGA IP supports a maximum clock frequency
of 100MHz.

Figure 34. Intel Arria 10 Partial Reconfiguration Controller
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2.3.1. Slave Interface: Intel Arria 10 Partial Reconfiguration Controller

The Partial Reconfiguration Controller IP core provides an Avalon-MM slave interface to
read and write to PR configuration registers.

Table 17. Data/CSR Memory Map Format

Name Address Offset Access Description

PR_DATA 0x00 Write Every data write to this address indicates this bitstream is
sent to the IP core.
Performing a read on this address returns all 0's.

PR_CSR 0x01 Read or Write Control and status registers.

Version
Register

0x02 Read-Only Read-only SW version register. Register is currently
0xAA500003

PR Bitstream ID 0x03 Read-Only Read-only PR POF ID register

Table 18. PR_CSR Control and Status Registers

Bit Offset Description

0 Read and write control register for pr_start signal. Refer to Ports: Intel Arria 10 Partial
Reconfiguration Controller on page 61 for details on the pr_start signal.
pr_start = PR_CSR[0]
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2. Partial Reconfiguration Solutions IP User Guide

UG-20136 | 2018.08.07

Partial Reconfiguration User Guide Intel® Quartus® Prime Pro Edition
57



Bit Offset Description

The IP core deasserts PR_CSR[0] to value 0 automatically, one clock cycle after the
PR_CSR[0] asserts. This streamlines the flow to avoid manual assertion and de-assertion
of this register to control pr_start signal.

1 Reserved.

2-4 Read-only status register for status[2:0] signal.
PR_CSR[4:2] = status[2:0]

Refer to Ports: Intel Arria 10 Partial Reconfiguration Controller on page 61 for details on
the status signals.

5 Read and clear bit for interrupt.
If you enable the interrupt interface, reading this bit returns the value of the irq signal.
Writing a 1 clears the interrupt.
If you disable the interrupt interface, reading this bit always returns a value of 0.

0-31 Reserved bits. Depends on the Avalon-MM data bus width.

Related Information

Avalon Interface Specifications

2.3.2. Reconfiguration Sequence: Intel Arria 10 Partial Reconfiguration
Controller

Partial reconfiguration occurs through the Avalon-MM slave interface in the following
sequence:

1. Avalon-MM master component writes 0x01 to IP address offset 0x1 to trigger PR
operation.

2. Optionally poll the status register until PR Operation in Progress. Not polling
results in waitrequest on first word.

3. Avalon-MM master component writes PR bitstream to IP address offset 0x0, until
all the PR bitstream writes. When enhanced decompression is on, waitrequest
activates throughout the PR operation. Ensure that your master can handle
waitrequest from the slave interface.

4. Avalon-MM master component reads the data from IP address offset 0x1 to check
the status[2:0] value. Optionally, the Avalon-MM master component reads the
status[2:0] of this IP during a PR operation to detect any early failure, for
example, PR_ERROR.

2.3.3. Interrupt Interface: Intel Arria 10 Partial Reconfiguration
Controller

If you enable the Avalon Memory Mapped Slave interface, you can use the optional
interrupt interface.
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The IP core asserts irq during the following events:

Table 19. Interrupt Interface Events

Status Code Event

3'b001 PR_ERROR occurred.

3'b010 CRC_ERROR occurred.

3'b011 The IP core detects an incompatible bitstream.

3'b101 The result of a successful PR operation.

After irq asserts, the master performs one or more of the following:

• Query for the status of the PR IP core; PR_CSR[4:2].

• Carry out some action, such as error reporting.

• Once the interrupt is serviced, clear the interrupt by writing a "1" to PR_CSR[5].

2.3.4. Parameters: Intel Arria 10 Partial Reconfiguration Controller

The Intel Arria 10 Partial Reconfiguration Controller IP core supports customization of
the following parameters.

Table 20. Intel Arria 10 Partial Reconfiguration Controller Parameter Settings

Parameter Value Description

Use as partial
reconfiguration
internal host

On/Off Enables the controller for use as an internal host. Enabling this option auto-
instantiates prblock and crcblock WYSIWYG as part of your design.
Disable this option to use the controller as an external host. Connect
additional interface signals to the dedicated partial reconfiguration pins.

Enable JTAG debug
mode

On/Off Enables access to the controller by the Intel Quartus Prime Programmer for
partial reconfiguration over a JTAG interface.

Enable Avalon-MM
slave interface

On/Off Enables the controller's Avalon-MM slave interface. When this setting is Off,
the IP controller enables the conduit interface.

Enable interrupt
interface

On/Off Enables interrupt assertion for detection of incompatible bitstream,
CRC_ERROR, PR_ERROR, or successful partial reconfiguration. Upon
interrupt, query PR_CSR[4:2] for status. Write a 1 to PR_CSR[5] to clear
the interrupt. Use only together with the Avalon-MM slave interface.

Enable freeze
interface

On/Off Enables the controller's single-bit freeze interface. This interface identifies
whether any region in the design is active or frozen for partial
reconfiguration operations.

Enable bitstream
compatibility check

On/Off Enables bitstream compatibility checks during partial reconfiguration
operation from the external host. Bitstream compatibility check
automatically enables when you use partial reconfiguration by internal host.
Specify the partial reconfiguration bitstream ID value if you enable this
option for partial reconfiguration by external host.

PR bitstream ID <32-bit
integer>

Specifies a signed, 32-bit integer value of the partial reconfiguration
bitstream ID for the external host. This value must match the partial
reconfiguration bitstream ID that the Compiler generates for the target
partial reconfiguration design. Locate the partial reconfiguration bitstream ID
of the target partial reconfiguration design in the Assembler report
(.asm.rpt).

Input data width 1|8|16|32 Specifies the size of the controller's data conduit interface in bits.
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Parameter Value Description

Clock-to-data ratio 1|4|8 Specifies the clock-to-data ratio that corresponds with the partial
reconfiguration bitstream data type. Refer to the Valid combinations and CD
Ratio for Bitstream Encryption and Compression Table.

Divide error detection
frequency by

1..256 Specifies the divide value of the internal clock. This value determines the
frequency of the error detection CRC. The divide value must be a power of
two. Refer to device documentation to determine the frequency of the
internal clock for the device you select.

Enable enhanced
decompression

On/Off Enable enhanced decompression of partial reconfiguration bitstreams.

Table 21. Intel Arria 10 Partial Reconfiguration Controller Advanced Settings

Parameter Value Description

Auto-instantiate
partial
reconfiguration
control block

On/Off Automatically includes the partial reconfiguration control block in the
controller. When using the controller as an internal host, disable this option
to share the partial reconfiguration block with other IP cores. Rather,
manually instantiate the partial reconfiguration control block, and connect
the relevant signals to the controller.

Auto-instantiate CRC
block

On/Off Automatically includes the CRC block within the controller. Leave this option
enabled unless you plan to use single event upset (SEU) IP in the same PR
design. If you disable this option, IP generation exports the crc_error_pin
for manual connection to an external CRC block that you manually
instantiate. If you disable this option and then subsequently leave the
exported crc_error_pin floating, the PR operation is undetermined due to
unexpected crc_error_pin.

Generate timing
constraints file

On/Off Automatically generates an appropriate Synopsys Design Constraints (.sdc)
file to constrain the timing of the controller. Disable this option when
providing timing constraints in another file.
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Figure 35. Intel Arria 10 Partial Reconfiguration Controller Parameter Editor

Related Information

Clock Networks and PLLs in Arria 10 Devices

2.3.5. Ports: Intel Arria 10 Partial Reconfiguration Controller

The Intel Arria 10 Partial Reconfiguration Controller includes the following interface
ports.
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Figure 36. Intel Arria 10 Partial Reconfiguration Controller Interface Ports (Internal
Host)

Figure 37. Intel Arria 10 Partial Reconfiguration Controller Interface Ports (External
Host)

Table 22. Clock/Reset Ports

Port Name Width Direction Function

nreset 1 Input Asynchronous reset for the PR Controller IP core. Resetting
the PR Controller IP core during a partial reconfiguration
operation initiates the withdrawal sequence.

clk 1 Input User input clock to the PR Controller IP core. The IP core
has a maximum clock frequency of 100MHz.
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Port Name Width Direction Function

The IP core ignores this signal during JTAG debug
operations.

Table 23. Freeze Interface Port

Port Name Width Direction Function

freeze 1 Output Active high signal that freezes the PR interface signals of
any region undergoing partial reconfiguration. De-assertion
of this signal indicates the end of PR operation.
Use the Partial Reconfiguration Region Controller IP rather
than the PR Controller IP freeze signal.

Table 24. Conduit Interface Ports
These ports are available when Enable Avalon-MM slave interface is Off.

Port Name Width Direction Function

pr_start 1 Input A 0 to 1 transition on this port initiates a PR event. You
must assert this signal high for a minimum of one clock
cycle, and de-assert the signal low prior to the end of the
PR operation. This operation ensures the PR Controller IP
core is ready to accept the next pr_start trigger event
when the freeze signal is low.
The PR Controller IP core ignores this signal during JTAG
debug operations.

data[] 1, 8, 16, or 32 Input Selectable input PR data bus width, either x1, x8, x16, or
x32.
Once a PR event triggers, the PR event is synchronous with
the rising edge of the clk signal, whenever the
data_valid signal is high, and the data_ready signal is
high.
The PR Controller IP core ignores this signal during JTAG
debug operations.

data_valid 1 Input A 0 to 1 transition on this port indicates the data[] port
contains valid data.
The PR Controller IP core ignores this signal during JTAG
debug operations.

data_ready 1 Output A 0 to 1 transition on this port indicates the PR Controller IP
core is ready to read the valid data on the data[] port,
whenever the data_valid signal asserts high. The data
sender must stop sending valid data if this port is low.
This signal deasserts low during JTAG debug operations.

status[2..0] 1 Output A 3-bit output that indicates the status of PR events. When
the IP detects an error (PR_ERROR, CRC_ERROR, or
incompatible bitstream error), this signal latches high. This
signal only resets at the beginning of the next PR event,
when pr_start is high, and freeze is low. For example:
3’b000 – power-up or nreset asserts

3’b001 – PR_ERROR triggers

3’b010 – CRC_ERROR triggers

3’b011 – Incompatible bitstream error
detection

3’b100 – PR operation in progress

3’b101 – PR operation passes

3'b110 – Reserved bit

3'b111 – Reserved bit
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Table 25. Avalon-MM Slave Interface Ports
These signals are available when Enable Avalon-MM slave interface is On.

Port Name Width Direction Function

avmm_slave_address 4 Input Avalon-MM address bus. The address bus is in the unit
of Word addressing.
The PR Controller IP core ignores this signal during
JTAG debug operations.

avmm_slave_read 1 Input Avalon-MM read control.
The PR Controller IP core ignores this signal during
JTAG debug operations.

avmm_slave_readdata 32 Output Avalon-MM read data bus.
The PR Controller IP core ignores this signal during
JTAG debug operations.

avmm_slave_write 1 Input Avalon-MM write control.
The PR Controller IP core ignores this signal during
JTAG debug operations.

avmm_slave_writedata 32 Input Avalon-MM write data bus.
The PR Controller IP core ignores this signal during
JTAG debug operations.

avmm_slave_waitrequest 1 Output Indicates that the IP is busy. Also indicates that the IP
core is unable to respond to a read or write request.
The IP core pulls this signal high during JTAG debug
operations.

Table 26. Interrupt Interface Ports
These ports are available when Enable interrupt interface is On.

Port Name Width Direction Function

irq 1 Output The interrupt signal.

Table 27. CRC BLOCK Interface
These ports are available when Use as Partial Reconfiguration Internal Host is Off, or when you
instantiate the CRCBLOCK manually for an internal host.

Port Name Width Direction Function

crc_error_pin 1 Input Available when you use the PR Controller IP core as an
External Host. Connect this port to the dedicated
CRC_ERROR pin of the FPGA undergoing partial
reconfiguration.

Table 28. PR Block Interface
These options are available when Use as Partial Reconfiguration Internal Host is Off, or when you
instantiate the PRBLOCK manually for an internal host.

Port Name Width Direction Function

pr_ready_pin 1 Input Connect this port to the dedicated PR_READY pin of the
FPGA undergoing partial reconfiguration.

pr_error_pin 1 Input Connect this port to the dedicated PR_ERROR pin of the
FPGA undergoing partial reconfiguration.

pr_done_pin 1 Input Connect this port to the dedicated PR_DONE pin of the
FPGA undergoing partial reconfiguration.
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Port Name Width Direction Function

pr_request_pin 1 Output Connect this port to the dedicated PR_REQUEST pin of
the FPGA undergoing partial reconfiguration.

pr_clk_pin 1 Output Connect this port to the dedicated DCLK of the FPGA
undergoing partial reconfiguration.

pr_data_pin[31..0] 16|32 Output Connect this port to the dedicated DATA[31..0] pins of
the FPGA undergoing partial reconfiguration.

2.3.6. Timing Specifications: Intel Arria 10 Partial Reconfiguration
Controller

The following timing diagram illustrates a successful PR operation. The status[2:0]
output signal indicates whether the operations passes or fails. The PR operation
initiates upon assertion of the pr_start signal. Monitor the status[] signal to
detect the end of the PR operation.

Figure 38. Intel Arria 10 Partial Reconfiguration Controller Timing Specifications

clk

pr_start

status[2:0]

data[]

data_valid

data_ready

D1 (First Data) D2 D3 D6 (Last Data) Dummy DataD4 D5

(1)

(2) (3)

(4) (5)

(6) (7)

The following notes correspond to the numbers in the timing diagram:

1. Assert pr_start signal high for a minimum of one clock cycle to initiate PR.
Deassert pr_start before sending the last data.

2. status[] signal updates after pr_start is acknowledged. This signal changes
during a PR operation if CRC_ERROR, PR_ERROR, or bitstream incompatibility error
occurs.

3. status[] signal changes after a PR operation if CRC_ERROR asserts and no error
occurs during the previous PR operation.

4. There is no requirement to assert the data_valid signal at the same time as the
pr_start signal. Provide the data[], and assert data_valid, when
appropriate.
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5. Either drive the data_valid signal low after sending the last data, or continue to
assert data_valid high with dummy data on data[] until the IP reads the end
of PR from status[].

6. data[] transfers only when data_valid and data_ready assert on the same
cycle. Do not drive new data on the data bus, when both data_valid and
data_ready are not high.

7. The data_ready signal drives low after the PR IP Controller core receives the last
data, or when the PR IP Controller cannot accept data.

2.3.7. PR Control Block and CRC Block Verilog HDL Manual Instantiation

The Partial Reconfiguration Controller IP includes the PR control block. However, if you
create your own custom logic to perform the function of the IP core, you can manually
instantiate the control block to communicate with the FPGA system.

The following example instantiates a PR control block inside your top-level Intel Arria
10 PR project, Chip_Top, in Verilog HDL:

Chip_Top:
module Chip_Top (
 //User I/O signals (excluding PR related signals)
..
..
//PR interface and configuration signals declaration
 wire pr_request;
 wire pr_ready;
 wire pr_done;
 wire crc_error;
 wire dclk;
 wire [31:0] pr_data;

twentynm_prblock m_pr
 (
 .clk (dclk),
 .corectl (1'b1),
 .prrequest(pr_request),
 .data (pr_data),
 .error (pr_error),
 .ready (pr_ready),
 .done (pr_done)
 );

twentynm_crcblock m_crc
 (
 .clk (clk),
 .shiftnld (1'b1),
 .crcerror (crc_error)
 );
endmodule

For more information about port connectivity for reading the Error Message Register
(EMR), refer to the AN539: Test Methodology of Error Detection and Recovery using
CRC.

Related Information

AN539: Test Methodology of Error Detection and Recovery using CRC in Altera FPGA
Devices
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2.3.8. PR Control Block and CRC Block VHDL Manual Instantiation

The following example shows manual instantiation of a PR control block inside your
top-level Intel Arria 10 project, Chip_Top, in VHDL:

module Chip_Top is port (
 --User I/O signals (excluding signals that relate to PR)
 ..
 ..
 )
-- Following shows the connectivity within the Chip_Top module
Core_Top : Core_Top
 port_map (
 ..
 ..
 );
m_pr : twentynm_prblock
 port map(
clk => dclk,
 corectl =>'1', --1 - when using PR from inside
 --0 - for PR from pins; You must also enable
 -- the appropriate option in Quartus Prime settings
 prrequest => pr_request,
 data => pr_data,
 error => pr_error,
 ready => pr_ready,
 done => pr_done
 );
m_crc : twentynm_crcblock
 port map(
 shiftnld => '1', --If you want to read the EMR register when
 clk => dummy_clk, --error occurrs, refer to AN539 for the
 --connectivity for this signal. If you only want
 --to detect CRC errors, but plan to take no
 --further action, you can tie the shiftnld
 --signal to logical high.
 crcerror => crc_error
 );

2.3.8.1. PR Control Block and CRC Block VHDL Component Declaration

The following example shows manual instantiation of the PR control block and the CRC
block in your Intel Arria 10 PR design:

1. Use the code sample below, containing the component declaration in VHDL. This
code performs the PR function from within the core (code block within Core_Top).

module Chip_Top is port (
    --User I/O signals (excluding signals that relate to PR)
    ..
    ..
)
-- Following shows the connectivity within the Chip_Top module
Core_Top : Core_Top
port_map (
    ..
    ..
);

m_pr : twentynm_prblock
port map(
    clk => dclk,
    corectl =>'1', --1 - when using PR from inside
    --0 - for PR from pins; You must also enable
    -- the appropriate option in Quartus Prime settings
    prrequest => pr_request,
    data => pr_data,
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    error => pr_error,
    ready => pr_ready,
    done => pr_done
);

m_crc : twentynm_crcblock
port map(
    shiftnld => '1', --If you want to read the EMR register when
    clk => dummy_clk, --error occurrs, refer to AN539 for the
    --connectivity forthis signal. If you only want
    --to detect CRC errors, but plan to take no
    --further action, you can tie the shiftnld
    --signal to logical high.
    crcerror => crc_error
);

Note: This VHDL example is adaptable for Verilog HDL instantiation.

2. Add additional ports to Core_Top to connect to both components.

3. Follow these rules when connecting the PR control block to the rest of your design:

• Set the corectl signal to ‘1’ (when using partial reconfiguration from core) or
to ‘0’ (when using partial reconfiguration from pins).

• The corectl signal must match the Enable PR pins option setting in the
Device and Pin Options dialog box (Assignments ➤ Device ➤ Device and
Pin Options).

• When performing partial reconfiguration from pins, the Fitter automatically
assigns the PR unassigned pins. Assign all the dedicated PR pins using Pin
Planner ( Assignments ➤ Pin Planner) or Assignment Editor (Assignments
➤ Assignment Editor).

• When performing partial reconfiguration from the core logic, connect the
prblock signals to either core logic or I/O pins, excluding the dedicated
programming pin, such as DCLK.

2.3.9. Control Block Signals: Intel Arria 10 Partial Reconfiguration
Controller

The following table lists the partial reconfiguration control block interface signals:

Table 29. PR Control Block Interface Signals

Signal Width Direction Description

pr_data [31:0] Input Carries the configuration
bitstream.

pr_done 1 Output Indicates that the PR
process is complete.

pr_ready 1 Output Indicates that the control
block is ready to accept PR
data from the control logic.
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Signal Width Direction Description

pr_error 1 Output Indicates a partial
reconfiguration error.

pr_request 1 Input Indicates that the PR
process is ready to begin.

corectl 1 Input Determines whether you are
performing the partial
reconfiguration internally, or
through pins.

Note: • Use data signal width of x8, x16, or x32 in your PR design.

• All the inputs and outputs are asynchronous to the PR clock (clk), except data
signal. data signal is synchronous to clk signal.

• PR clock must be free-running.

• data signal must be 0 while waiting for ready signal.

2.3.9.1. Intel Arria 10 PR Control Block Signal Timing Diagrams

2.3.9.1.1. Successful PR Session (Intel Arria 10 Example)

The following flow describes a successful Intel Arria 10 PR session:

1. Assert PR_REQUEST and wait for PR_READY; drive PR_DATA to 0.

2. The PR control block asserts PR_READY, asynchronous to clk.

3. Start sending Raw Binary File (.rbf) to the PR control block, with 1 valid word per
clock cycle. On .rbf file transfer completion, drive PR_DATA to 0. The PR control
block asynchronously asserts PR_DONE when the control block completes the
reconfiguration operation. The PR control block deasserts PR_READY on
configuration completion.

4. Deassert PR_REQUEST. The PR control block acknowledges the end of
PR_REQUEST, and deasserts PR_DONE. The host can now initiate another PR
session.

Figure 39. Timing Diagram for Successful Intel Arria 10 PR Session

S0 S1

S2

S3

S4

S5 S6

PR_REQUEST

PR_CLK

PR_READY

PR_DONE

New PR Session

     First Data Last Data

Minimum Width Requirement of 6 cycles on 
PR_REQUEST to Initiate a PR Session

PR_DATA [x:0]

Related Information

Raw Binary Programming File Byte Sequence Transmission Examples on page 34
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2.3.9.1.2. Unsuccessful PR Session with Configuration Frame Readback Error (Intel Arria
10 Example)

The following flow describes an Intel Arria 10 PR session with error in the EDCRC
verification of a configuration frame readback:

1. The PR control block internally detects a CRC error.

2. The CRC control block then asserts CRC_ERROR.

3. The PR control block asserts the PR_ERROR.

4. The PR control block deasserts PR_READY, so that the host can withdraw the
PR_REQUEST.

5. The PR control block deasserts CRC_ERROR and clears the internal CRC_ERROR
signal to get ready for a new PR session. The host can now initiate another PR
session.

Figure 40. Timing Diagram for Unsuccessful Intel Arria 10 PR Session with Configuration
Frame Readback Error
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2.3.9.1.3. Unsuccessful PR Session with PR_ERROR (Intel Arria 10 Example)

The following flow describes an Intel Arria 10 PR session with transmission error or
configuration CRC error:

1. The PR control block asserts PR_ERROR.

2. The PR control block deasserts PR_READY, so that the host can withdraw
PR_REQUEST.

3. The PR control block deasserts PR_ERROR to get ready for a new PR session. The
host can now initiate another PR session.
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Figure 41. Timing Diagram for Unsuccessful Intel Arria 10 PR Session with PR_ERROR
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2.3.9.1.4. Late Withdrawal PR Session (Intel Arria 10 Example)

The following flow describes a late withdrawal Intel Arria 10 PR session:

1. The PR host can withdraw the request after the PR control block asserts
PR_READY.

2. The PR control block deasserts PR_READY. The host can now initiate another PR
session.

Figure 42. Timing Diagram for Late Withdrawal Intel Arria 10 PR Session
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Note: The PR host can withdraw the request any time before the controller asserts
PR_READY. Therefore, the PR host must not return until the PR control block asserts
PR_READY. Provide at least 10 PR_CLK cycles after deassertion of PR_REQUEST,
before requesting a new PR session.

2.3.10. Configuring an External Host for Intel Arria 10 Designs

When using external host configuration, the external host initiates partial
reconfiguration, and monitors the PR status using the external PR dedicated pins
during user mode. In this mode, the external host must respond appropriately to the
handshake signals for successful partial reconfiguration. The external host writes the
partial bitstream data from external memory into the Intel Arria 10 device. Co-
ordinate system-level partial reconfiguration by ensuring that you prepare the correct
PR region for partial reconfiguration. After reconfiguration, return the PR region into
operating state.
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To use an external host for your design:

1. Click Assignments ➤ Device ➤ Device & Pin Options.

2. Select the Enable PR Pins option in the Device & Pin Options dialog box. This
option automatically creates the special partial reconfiguration pins, and defines
the pins in the device pin-out. This option also automatically connects the pins to
PR control block internal path.

Note: If you do not select this option, you must use an internal or HPS host. You
do not need to define pins in your design top-level entity.

3. Connect these top-level pins to the specific ports in the PR control block.

The following table lists the automatically constrained PR pins when you select Enable
PR Pins option, and the specific PR control block port to connect these pins to:

Table 30. Partial Reconfiguration Dedicated Pins

Pin Name Type PR Control Block Port
Name

Description

PR_REQUEST Input prrequest Logic high on this pin
indicates that the PR host is
requesting partial
reconfiguration.

PR_READY Output ready Logic high on this pin
indicates that the PR control
block is ready to begin
partial reconfiguration.

PR_DONE Output done Logic high on this pin
indicates that the partial
reconfiguration is complete.

PR_ERROR Output error Logic high on this pin
indicates an error in the
device during partial
reconfiguration.

DATA[31:0] Input data These pins provide
connectivity for PR_DATA to
transfer the PR bitstream to
the PR controller.

DCLK Input clk Receives synchronous
PR_DATA.

Note: 1. PR_DATA can be 8, 16, or 32-bits in width.

2. Ensure that you connect the corectl port of the PR control block to 0.

Example 5. Verilog RTL for External Host PR

module top(
     // PR control block signals
     input  logic        pr_clk,
     input  logic        pr_request,
     input  logic [31:0] pr_data,
     output logic        pr_error,
     output logic        pr_ready,
     output logic        pr_done,

     // User signals
     input  logic i1_main,
     input  logic i2_main,
     output logic o1

2. Partial Reconfiguration Solutions IP User Guide

UG-20136 | 2018.08.07

Partial Reconfiguration User Guide Intel® Quartus® Prime Pro Edition
72



);

// Instantiate the PR control block
twentynm_prblock m_prblock
(
    .clk(pr_clk),
    .corectl(1'b0),
    .prrequest(pr_request),
    .data(pr_data),
    .error(pr_error),
    .ready(pr_ready),
    .done(pr_done)
);

// PR Interface partition
pr_v1 pr_inst(
   .i1(i1_main),
   .i2(i2_main),
   .o1(o1)
);

endmodule

Example 6. VHDL RTL for External Host PR

library ieee;
use ieee.std_logic_1164.all;

entity top is
port(
      -- PR control block signals
      pr_clk: in std_logic;
      pr_request: in std_logic;
      pr_data: in std_logic_vector(31 downto 0);
                
      pr_error: out std_logic;
      pr_ready: out std_logic;
      pr_done: out std_logic;
                
      -- User signals
      i1_main: in std_logic;
      i2_main: in std_logic;
      o1: out std_logic
);
end top;

architecture behav of top is

component twentynm_prblock is
port(      
      clk: in std_logic;
      corectl: in std_logic;
      prrequest: in std_logic;
      data: in std_logic_vector(31 downto 0);
      error: out std_logic;
      ready: out std_logic;
      done: out std_logic
);
end component;

component pr_v1 is
port(     
      i1: in std_logic;
      i2: in std_logic;
      o1: out std_logic
);
end component;

signal pr_gnd : std_logic;
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begin

pr_gnd <= '0';

-- Instantiate the PR control block
m_prblock: twentynm_prblock port map
(
    pr_clk,
    pr_gnd,
    pr_request,
    pr_data,
    pr_error,
    pr_ready,
    pr_done
);

-- PR Interface partition
pr_inst : pr_v1 port map
(
   i1_main,
   i2_main,
   o1
);

end behav;

2.4. Partial Reconfiguration External Configuration Controller Intel
Stratix 10 FPGA IP

The Partial Reconfiguration External Configuration Controller Intel Stratix 10 FPGA IP
supports partial reconfiguration via an external source over dedicated PR pins.

When using external configuration, you must connect all the top-level ports of the
Partial Reconfiguration External Configuration Controller Intel Stratix 10 FPGA IP to the
pr_request and status pins, to allow the handshaking of the host with SDM from
the Intel Stratix 10 core. The SDM determines which types of configuration pins to
use, according your MSEL setting.

Figure 43. Partial Reconfiguration External Configuration Controller Intel Stratix 10
FPGA IP
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2.4.1. Parameters: Intel Stratix 10 Partial Reconfiguration External
Configuration Controller

The Partial Reconfiguration External Configuration Controller Intel Stratix 10 FPGA IP
supports customization of the following parameters.

Table 31. Partial Reconfiguration External Configuration Controller Parameter Settings

Parameter Value Description

Enable Busy Interface On/Off Allows you to Enable or Disable the Busy interface, which asserts a signal to
indicate that PR processing is in progress during external configuration.

Figure 44. Parameter Editor

2.4.2. Ports: Intel Stratix 10 Partial Reconfiguration External
Configuration Controller

The Partial Reconfiguration External Configuration Controller includes the following
interface ports.

Table 32. Ports

Port Name Width Direction Function

pr_request 1 Input Indicates that the PR process is ready to begin. The signal is
a conduit not synchronous to any clock signal.

pr_error 1 Output Indicates a partial reconfiguration error. The signal is a
conduit not synchronous to any clock signal.

pr_done 1 Output Indicates that the PR process is complete. The signal is a
conduit not synchronous to any clock signal.
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Port Name Width Direction Function

start_addr 1 Input Specifies the start address of PR data in Active Serial Flash.
You enable this signal by selecting either Avalon-ST or
Active Serial for the Enable Avalon-ST Pins or Active
Serial Pins parameter. The signal is a conduit not
synchronous to any clock signal.

reset 1 Input Active high, synchronous reset signal.

out_clock 1 Output Clock source that generates from an internal oscillator.

busy 1 Output The IP asserts this signal to indicate PR data transfer in
progress. You enable this signal by selecting Enable for the
Enable busy interface parameter.

2.4.3. Configuring an External Host for Intel Stratix 10 Designs

You can optionally use an external host to write the partial bitstream data from
external memory into the Intel Stratix 10 device. When using external host
configuration, the external host initiates partial reconfiguration by asserting the
pr_request signal. The external host monitors the PR status through the pr_done
and pr_error signals.

The external host must respond appropriately to the handshake signals for successful
partial reconfiguration. Co-ordinate system-level partial reconfiguration by ensuring
that you prepare the correct PR region for partial reconfiguration. After
reconfiguration, return the PR region into operating state.

To configure an external host for Intel Stratix 10 designs, follow these steps:

1. Parameterize and generate the Partial Reconfiguration External Configuration
Controller Intel Stratix 10 FPGA IP, as Generating IP Cores (Intel Quartus Prime
Pro Edition) on page 99 describes.

2. Connect the Partial Reconfiguration External Configuration Controller
pr_request, pr_done, and pr_error signals to top-level pins for control and
monitor by the external host. You can assign the pin location by clicking
Assignments ➤ Pin Planner.

3. Click Assignments ➤ Device, and then click the Device & Pin Options button.

4. In the Category list, click Configuration.

5. For the Configuration scheme, select the scheme that matches with your full
device configuration. For example, if your full device configuration uses the
AVSTx32 scheme, the PR configuration must use AVSTx32.This option
automatically reserves dedicated Avalon-ST configuration pins for partial
reconfiguration during user mode. The pins are exactly same as the Avalon-ST
pins that you use for full device configuration.

The following table describes the PR pins that the external host uses. The PR
streaming to Avalon-ST pins must conform to the Avalon-ST specification for data
transfer with backpressure.
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Table 33. Partial Reconfiguration External Configuration Pins

Pin Name Type Description

pr_request Input User-assigned port connected to Partial Reconfiguration External
Configuration Controller IP. Logic high on this pin indicates that
the PR host is requesting partial reconfiguration.

pr_done Output User-assigned port connected to Partial Reconfiguration External
Configuration Controller IP. Logic high on this pin indicates that
the partial reconfiguration is complete.

pr_error Output User-assigned port connected to Partial Reconfiguration External
Configuration Controller IP. Logic high on this pin indicates an
error in the device during partial reconfiguration.

avst_data:
avstx8 - [7:0]
avstx16 - [15:0]
avstx32 - [31:0]

Input These pins provide connectivity for the external host to transfer
the PR bitstream to the SDM. The avstx8 data pins are part of
the SDM I/O. avstx16 and avstx32 data pins are from I/O 48
bank 3A.

avst_clk Input Clocks the Avalon-ST interfaces. avst_data and avst_valid
are synchronous with avst_clk. The avstx8 clk pin is part of
the SDM I/O. avstx16 and avstx32 are from I/O 48 bank 3A.

avst_valid Input Logic high on this pin indicates the data in avst_data is valid
data. The avstx8 data pins are part of the SDM I/O. avstx16
and avstx32 data pins are from I/O 48 bank 3A.

avst_ready Output Logic high on this pin indicates the SDM is ready to accept data
from an external host. This output is part of the SDM I/O.

2.5. Partial Reconfiguration Region Controller Intel FPGA IP

The Partial Reconfiguration Region Controller Intel FPGA IP provides a standard
interface through the Freeze Control block that controls handshaking with the PR
region. The PR handshake ensures that PR region transactions complete before freeze
of the interface.

Figure 45. Partial Reconfiguration Region Controller IP Core
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Table 34. PR Region Controller Register Map

IP Component Description

Freeze Control and Status Register Freeze status register that generates the freeze output signal.

Freeze Control Block Performs PR handshaking and resets the PR region.

Conduit Splitter Connects the controller's freeze signal to one or more Freeze Bridge
components. Receives the freeze signal from the Freeze Control
Block, and assigns the freeze input signal to one or more freeze
output signals.

Conduit Merger Connects the illegal_request signal from one or more Freeze
Bridge components to the PR Region Controller.
The illegal_request is a single-bit output signal from the Freeze
Bridge. Conduit Merger concatenates the single-bit signal from multiple
Freeze Bridges into a multi-bit bus. The Conduit Merger then connects
the bus to the Freeze Control Block.

2.5.1. Registers: Partial Reconfiguration Region Controller

The Partial Reconfiguration Region Controller IP core performs the following operations
in a partial reconfiguration:

Figure 46. Freeze Control Block PR Handshake Timing
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Figure 47. Partial Reconfiguration Region Controller Register States and Programming
Model
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Table 35. Partial Reconfiguration Region Controller Register Map

Name Address
Offset

Access Description

freeze_csr_status 0x00 Read-Only Freeze status register.

csr_ctrl 0x01 Read or Write Control register to enable and disable freeze.

freeze_illegal_req 0x02 Read or Write High on any bit indicates an illegal request
during the freeze state.

freeze_reg_version 0x03 Read-Only Read-only version register. This register is
currently 0xAD000003.

Table 36. freeze_csr_status

Bit Fields Access Default
Value

Description

31:2 Reserved N/A 0x0 Reserved bits. Reading these bits always returns
zeros.

1 unfreeze_status R 0 Hardware sets this bit to 1 after the PR region
returns start_ack to indicate successful start
of the persona.
Hardware clears this bit to 0 when the
unfreeze_req bit is low.
This bit is 1 when the bridge is releases from
reset.

0 freeze_status R 0 Hardware sets this bit to 1 after the PR region
returns the stop_ack signal to indicate that the
PR region is ready to enter the frozen state
Hardware clears this bit to 0 when the
freeze_req bit is low.
This bit is 0 when the bridge is releases from
reset.

Table 37. freeze_csr_ctrl

Bit Fields Access Default
Value

Description

31:3 Reserved N/A 0x0 Reserved bits. Reading these bits always returns
zeros.

2 unfreeze_req R/W 0 Write 1 to this bit to request unfreezing the PR
region interfaces.
Hardware clears this bit after the
unfreeze_status is high.
Write 0 to this bit to terminate the unfreeze
request.
Do not assert this bit and the freeze_req bit
at the same time. If both freeze_req and
unfreeze_req assert at the same time, it is an
invalid operation.

1 reset_req R/W 0 Write 1 to start resetting the PR persona.
Write 0 to stop resetting the PR persona.

0 freeze_req R/W 0 Write 1 to this bit to start freezing the PR region
interfaces.

Hardware clears this bit after freeze_status
is high.
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Bit Fields Access Default
Value

Description

Write 0 to this bit to terminate the freeze
request if the PR region freeze bridge never
returns stop_ack after this bit asserts.

Do not assert this bit and unfreeze_req bit at
the same time. Asserting freeze_req and
unfreeze_req simultaneously is an invalid
operation.

Table 38. freeze_illegal_request

Bit Fields Access Default
Value

Description

31:n Reserved N/A 0x0 Reserved bits. Reading these bits always returns
zeros.

n-1:0 illegal_request R/W 0 High on any bit of this bus indicates a read or
write issues by the static region master when
the Avalon-MM slave freeze bridge is in freeze
state. Identify which freeze bridge has an illegal
request by checking each bit on the bus.
For example, when illegal_request bit 2 is
high, illegal request occurs in the freeze bridge
that connects to interface
freeze_conduit_in2

This bus triggers the interrupt signal. Write 1 to
clear this bit. n is the number of bridges.

Table 39. freeze_reg_version

Bit Fields Access Default
Value

Description

31:0 Version Register Read-Only AD000003 This register bit indicates the CSR register
version number. Currently the CSR register is
version 0xAD000003.

2.5.2. Parameters: Partial Reconfiguration Region Controller

The Partial Reconfiguration Region Controller IP core supports customization of the
following parameters.

Table 40. Partial Reconfiguration Region Controller Parameter Settings

Parameter Value Default Description

Enable Avalon-MM CSR
register

On/Off On Enables Avalon-MM CSR registers in the PR region controller.
Disable this option to expose a conduit interface and not
instantiate the CSR block.

Enable interrupt port
for illegal request

On/Off On Enables the interrupt port for illegal operations in the PR region
controller.
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Parameter Value Default Description

Number of freeze
interfaces

number Specifies the number of freeze interfaces for freeze operations.
Each freeze interface connects to a freeze bridge.

Enable freeze interface
without illegal request
port

On/Off Off Enables creation of additional freeze interface, without the illegal
request port.

Specify the number of
freeze interfaces
without illegal request
port

number Specifies the number of freeze interfaces without illegal request
port for freeze operations. Only available when you turn on
Enable freeze interface without illegal request port.

Figure 48. Partial Reconfiguration Region Controller Parameter Editor

2.5.3. Ports: Partial Reconfiguration Region Controller

Table 41. Freeze CSR Block Ports
These ports are available when Enable Avalon-MM CSR Register is On.

Port Width Direction Description

clock_clk 1 Input IP core input clock.

Reset

reset_reset 1 Input Synchronous reset.

avl_csr_addr 2 Input Avalon-MM address bus. The address bus is in word addressing.

avl_csr_read 1 Input Avalon-MM read control to CSR block.

avl_csr_write 1 Input Avalon-MM write control to CSR.
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Port Width Direction Description

avl_csr_writedata 32 Input Avalon-MM write data bus to CSR.

avl_csr_readdata 32 Output Avalon-MM read data bus from CSR.

interrupt_sender_irq 1 output Trigger by illegal read or illegal write.

Table 42. Freeze Control Block Ports

Port Width Direction Description

pr_handshake_stop_req 1 Output An assertion on this output requests that the PR persona
stop executing.

pr_handshake_stop_ack 1 Input A value of 1 on this input acknowledges that the executing
PR persona stops executing and a new persona can replace
it.

pr_handshake_start_req 1 Output An assertion on this output requests that the new PR
persona starts executing.

pr_handshake_start_ack 1 Input A value of 1 on this input acknowledges that the new PR
persona starts executing and can stop executing on a
pr_handshake_stop_req.

conduit_control_freeze_req 1 Input Write 1 on this bit to start freezing the PR region interfaces.

conduit_control_unfreeze_req 1 Input Write 1 on this bit to stop freezing the PR region interfaces.

conduit_control_freeze_status 1 Output High on this bit indicates that the PR region is successfully
goes into freezing state.

conduit_control_reset 1 Input Write 1 on this bit to reset the PR region.

conduit_control_unfreeze_status 1 Output High on this bit indicates that the PR region successfully
leaves freezing state.

conduit_control_illegal_req n Output High on this bit indicates illegal reads/writes on the Avalon-
MM Slave Bridge.

Table 43. Conduit Splitter and Merger Interface Ports

Signal Width Direction Description

bridge_freeze0_freeze 1 Output This output connects to freeze input signal of freeze bridge
block. (Multiple interfaces generate according to the number
of freeze interfaces)

bridge_freeze0_illegal_request 1 Input This input connects to illegal_request output signal from
freeze bridge block
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Figure 49. Partial Reconfiguration Region Controller Interface Ports (Control and Status
Register Block Enabled)

Figure 50. Partial Reconfiguration Region Controller Interface Ports (Control and Status
Register Block Disabled)

2.6. Avalon-MM Partial Reconfiguration Freeze Bridge Intel FPGA IP

The Avalon-MM Partial Reconfiguration Freeze Bridge freezes the PR region interface
when the freeze input signal is high. Each interface to a PR region requires an
instance of the Freeze Bridge or your own freeze logic.
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Figure 51. Avalon-MM Partial Reconfiguration Freeze Bridge
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Table 44. Read and Write Request to PR Region Avalon-MM Slave Interface
The Freeze Bridge handles read and write transactions differently for each of the following possible interface
configurations. The Freeze Bridge is in the freeze state until the PR region or PR region controller is asserts the
freeze signal.

Interface Connection Behavior

Read request to Avalon-MM slave
interface in PR region

1. During the freeze state, any read transaction responds with bogus data
<’hDEADBEEF>. The corresponding freeze_illegal_request register
bit sets.

2. During the freeze state, readrequest, writerequest,
waitrequest, beginbursttransfer, lock, and debugaccess signals
in the PR region interface tie low.

3. The Avalon-MM slave response signal constantly returns 2’b10, to indicate
an unsuccessful transaction from an endpoint slave.

4. If you disable Enable Freeze port from PR region, the IP generates no
responses.

Write request to slave interface in PR
region

1. the Freeze Bridge ignores any write transactions during the freeze state.
The Freeze Bridge pulls the waitrequest, beginbursttransfer, lock
and debugaccess signals low. The IP sets the corresponding
freeze_illegal_request register bit.

2. The Avalon-MM slave response signal updates with 2’b10 to indicate an
unsuccessful transaction from an endpoint slave.

3. If you disable Enable Freeze port from PR region, the IP generates no
responses.

Table 45. Read and Write Request from PR Region Avalon-MM Master Interface

Interface Connection Behavior

Read/Write request from Avalon-MM
master interface in PR region

1. During the freeze state the IP ignores the read and write signals from
the PR region.

2. The read and write signals to the static region deassert.

Table 46. Avalon-MM Partial Reconfiguration Freeze Bridge Signal Behavior
The table below summarizes the Avalon interface output signal behavior when the Freeze Bridge is in a frozen
state. When not frozen, all signals are just pass-through.

Signal Avalon-MM Slave Bridge Avalon-MM Master Bridge

write ‘b0 (tie low) ‘b0 (tie low)

read ‘b0 (tie low) ‘b0 (tie low)

address Pass through Pass through

writedata Pass through Pass through

readdata Return <h’DEADBEEF> always Pass through
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Signal Avalon-MM Slave Bridge Avalon-MM Master Bridge

byteenable Pass through Pass through

burstcount Pass through Pass through

beginbursttransfer ‘b0 (tie low) ‘b0 (tie low)

debugaccess ‘b0 (tie low) ‘b0 (tie low)

readdatavalid Return ‘b1 when there is a request, else ‘b0 Pass through

waitrequest Return ‘b1 when there is a request, else ‘b0 ‘b0 (tie low)

response Return ‘b10 always Pass through

lock ‘b0 (tie low) ‘b0 (tie low)

writeresponsevalid Return ‘b1 when there is a request, else ‘b0 Pass through

2.6.1. Parameters: Avalon-MM Partial Reconfiguration Freeze Bridge

The Avalon-MM Partial Reconfiguration Freeze Bridge IP core supports customization of
the following parameters.

Table 47. Avalon-MM Partial Reconfiguration Freeze Bridge Parameters

Parameter Values Description

PR region interface Type Avalon-MM Slave/Avalon-
MM Master

Specifies the interface type for interfacing with the
Freeze Bridge.

Enable Freeze port from PR
region

On/Off Enables the freeze port that freezes all the
outputs of each PR region to a known constant
value. Freezing prevents the signal receivers in the
static region from receiving undefined signals
during the partial reconfiguration process. The
freeze of a bridge is the logical OR of this signal
from the PR region, and the freeze from the PR
region controller.

Enable the bridge to track
unfinish transaction

On/Off Enables the bridge to track unfinished transactions
before freezing the Avalon interface. Turn on this
option when there is no custom logic to stop the
Avalon transaction between the PR region and the
static region. If you do not need this feature,
disable this option to reduce the size of the IP.

Enabled Avalon Interface Signal Yes/No Enable (Yes) or disable (No) specific optional
Freeze Bridge interface ports.

Address width <1-64> Address width in bits.

Symbol width <number> Data symbol width in bits. The symbol width should
be 8 for byte-oriented interfaces.

Number of symbols <number> Number of symbols per word.

Burstcount width <number> The width of the burst count in bits.

Linewrap burst On/Off When On, the address for bursts wraps instead of
incrementing. With a wrapping burst, when the
address reaches a burst boundary, the address
wraps back to the previous burst boundary.
Consequently, the IP uses only the low order bits
for addressing.

Constant burst behavior On/Off When On, memory bursts are constant.
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Parameter Values Description

Burst on burst boundaries only On/Off When On, memory bursts are aligned to the
address size.

Maximum pending reads <number> The maximum number of pending reads that the
slave can queue.

Maximum pending writes <number> The maximum number of pending writes that the
slave can queue.

Fixed read latency (cycles) <number> Sets the read latency for fixed-latency slaves. Not
useful on interfaces that include the
readdatavalid signal.

Fixed read wait time (cycles) <number> For master interfaces that do not use the
waitrequest signal. The read wait time indicates
the number of cycles before the master responds to
a read. The timing is as if the master asserted
waitrequest for this number of cycles.

Fixed write wait time (cycles) <number> For master interfaces that do not use the
waitrequest signal. The write wait time indicates
the number of cycles before the master accepts a
write.

Address type WORDS/SYMBOLS Sets slave interface address type to symbols or
words.
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Figure 52. Parameter Editor

2.6.2. Interface Ports: Avalon-MM Partial Reconfiguration Freeze Bridge

Table 48. Avalon-MM Partial Reconfiguration Freeze Bridge Interface Ports

Port Width Direction Description

clock 1 Input Input clock for the IP.

reset_n 1 Input Synchronous reset for the IP.

freeze_conduit_freeze 1 Input When this signal is high, the bridge handles
any current transaction properly then
freezes the PR interfaces.

freeze_conduit_illegal_request 1 Output High on this bus indicates that an illegal
request issues to the bridge during freezing
state.

pr_freeze_pr_freeze 1 Input Enabled freeze port from the PR region.

2. Partial Reconfiguration Solutions IP User Guide

UG-20136 | 2018.08.07

Partial Reconfiguration User Guide Intel® Quartus® Prime Pro Edition
88



Table 49. Avalon-MM Slave to PR Region Master Interface Ports

Port Width Direction Description

slv_bridge_to_pr_read 1 Output Optional Avalon-MM slave bridge to PR
region read port.

slv_bridge_to_pr_waitrequest 1 Input Optional Avalon-MM slave bridge to PR
region waitrequest port.

slv_bridge_to_pr_write 1 Output Optional Avalon-MM slave bridge to PR
region write port.

slv_bridge_to_pr_address 32 Output Optional Avalon-MM slave bridge to PR
region address port.

slv_bridge_to_pr_byteenable 4 Output Optional Avalon-MM slave bridge to PR
region byteenable port.

slv_bridge_to_pr_writedata 32 Output Optional Avalon-MM slave bridge to PR
region writedata port.

slv_bridge_to_pr_readdata 32 Input Optional Avalon-MM slave bridge to PR
region readdata port.

slv_bridge_to_pr_burstcount 3 Output Optional Avalon-MM slave bridge to PR
region burstcount port.

slv_bridge_to_pr_readdatavalid 1 Input Optional Avalon-MM slave bridge to PR
region readdatavalid port.

slv_bridge_to_pr_beginbursttransfer 1 Output Optional Avalon-MM slave bridge to PR
region readdatavalid port.

slv_bridge_to_pr_debugaccess 1 Output Optional Avalon-MM slave bridge to PR
region debugaccess port.

slv_bridge_to_pr_response 2 Input Optional Avalon-MM slave bridge to PR
region response port.

slv_bridge_to_pr_lock 1 Output Optional Avalon-MM slave bridge to PR
region lock port.

slv_bridge_to_pr_writeresponsevalid 1 Input Optional Avalon-MM slave bridge to PR
region writeresponsevalid port.

Table 50. Avalon-MM Slave to Static Region Master Interface Ports

Note: Same setting as Avalon-MM master to PR region slave interface.

Port Width Direction Description

slv_bridge_to_sr_read 1 Input Avalon-MM slave bridge to static region
read port.

slv_bridge_to_sr_waitrequest 1 Output Avalon-MM slave bridge to static region
waitrequest port.

slv_bridge_to_sr_write 1 Input Avalon-MM slave bridge to static region
write port.

slv_bridge_to_sr_address 32 Input Avalon-MM slave bridge to static region
address port.

slv_bridge_to_sr_byteenable 4 Input Avalon-MM slave bridge to static region
byteenable port.
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Port Width Direction Description

slv_bridge_to_sr_writedata 32 Input Avalon-MM slave bridge to static region
writedata port.

slv_bridge_to_sr_readdata 32 Output Avalon-MM slave bridge to static region
readdata port.

slv_bridge_to_sr_burstcount 3 Input Avalon-MM slave bridge to static region
burstcount port.

slv_bridge_to_sr_beginbursttransfer 1 Input Avalon-MM slave bridge to static region
beginbursttransfer port.

slv_bridge_to_sr_ debugaccess 1 Input Avalon-MM slave bridge to static region
debugaccess port.

slv_bridge_to_sr_response 2 Output Avalon-MM slave bridge to static region
response port.

slv_bridge_to_sr_lock 1 Input Avalon-MM slave bridge to static region
lock port.

slv_bridge_to_sr_writeresponsevalid 1 Output Avalon-MM slave bridge to static region
writereponsevalid port.

Table 51. Avalon-MM Master to PR Region Slave Interface Ports

Port Width Direction Description

mst_bridge_to_pr_read 1 Input Optional Avalon-MM master bridge to PR
region read port.

mst_bridge_to_pr_waitrequest 1 Output Optional Avalon-MM master bridge to PR
region waitrequest port.

mst_bridge_to_pr_write 1 Input Optional Avalon-MM master bridge to PR
region write port.

mst_bridge_to_pr_address 32 Input Optional Avalon-MM master bridge to PR
region address port.

mst_bridge_to_pr_byteenable 4 Input Optional Avalon-MM master bridge to PR
region byteenable port.

mst_bridge_to_pr_writedata 32 Input Optional Avalon-MM master bridge to PR
region writedata port.

mst_bridge_to_pr_readdata 32 Output Optional Avalon-MM master bridge to PR
region readdata port.

mst_bridge_to_pr_burstcount 3 Input Optional Avalon-MM master bridge to PR
region burstcount port.

mst_bridge_to_pr_readdatavalid 1 Output Optional Avalon-MM master bridge to PR
region readdatavalid port.

mst_bridge_to_pr_beginbursttransfer 1 Input Optional Avalon-MM master bridge to PR
region beginbursttransfer port.

mst_bridge_to_pr_debugaccess 1 Input Optional Avalon-MM master bridge to PR
region debugaccess port.
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Port Width Direction Description

mst_bridge_to_pr_response 2 Output Optional Avalon-MM master bridge to PR
region response port.

mst_bridge_to_pr_lock 1 Input Optional Avalon-MM master bridge to PR
region lock port.

mst_bridge_to_pr_writeresponsevalid 1 Output Optional Avalon-MM master bridge to PR
region writeresponsevalid port.

Table 52. Avalon-MM Master to Static Region Slave Interface Ports
Same setting as Avalon-MM slave to PR region master interface.

Port Width Direction Description

mst_bridge_to_sr_read 1 Output Avalon-MM master bridge to static region
read port.

mst_bridge_to_sr_waitrequest 1 Input Avalon-MM master bridge to static region
read port.

mst_bridge_to_sr_write 1 Output Avalon-MM master bridge to static region
read port.

mst_bridge_to_sr_address 32 Output Avalon-MM master bridge to static region
address port.

mst_bridge_to_sr_byteenable 4 Output Avalon-MM master bridge to static region
byteenable port.

mst_bridge_to_sr_writedata 32 Output Avalon-MM master bridge to static region
writedata port.

mst_bridge_to_sr_readdata 32 Input Avalon-MM master bridge to static region
readdata port.

mst_bridge_to_sr_burstcount 3 Output Avalon-MM master bridge to static region
burstcount port.

mst_bridge_to_sr_readdatavalid 1 Input Avalon-MM master bridge to static region
readdatavalid port.

mst_bridge_to_sr_beginbursttransfer 1 Output Avalon-MM master bridge to static region
beginbursttransfer port.

mst_bridge_to_sr_debugaccess 1 Output Avalon-MM master bridge to static region
debugaccess port.

mst_bridge_to_sr_response 2 Input Avalon-MM master bridge to static region
response port.

mst_bridge_to_sr_lock 1 Output Avalon-MM master bridge to static region
lock port.

mst_bridge_to_sr_writeresponsevalid 1 Input Avalon-MM master bridge to static region
writeresponsevalid port.
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Figure 53. Avalon-MM Master Interface Ports

Figure 54. Avalon-MM Slave Interface Ports
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2.7. Avalon-ST Partial Reconfiguration Freeze Bridge Intel FPGA IP

The Avalon-ST Freeze Bridge component freezes the PR region interface when the
freeze input signal is high. The Freeze Bridge ensures that any transaction is
complete before freezing the connected interface. Each interface to a PR region
requires an instance of the Freeze Bridge or your own freeze logic.

Figure 55. Avalon-ST Partial Reconfiguration Freeze Bridge

Freeze Bridge
IP

Avalon-ST
Source/Sink

Freeze Conduit

Avalon-ST
Source/Sink

freeze illegal_request

Table 53. Avalon-ST Source Freeze Bridge Interface Behavior

Interface Type Behavior

Source bridge with packet transfer 1. When the freeze signal goes high, the Freeze Bridge handles the
startofpacket, endofpacket, and empty bits and does not send
transactions to the static region.

2. When the Freeze Bridge detects a startofpacket transaction without a
corresponding endofpacket during the frozen state, this indicates an
unfinished transaction.

3. The source bridge then completes the transaction by asserting valid and
endofpacket high for one clock cycle.

4. The channel signal remains constant, while data bits are set to
'hDEADBEEF and error bit is set to 1’b1.

5. The illegal_request output signal triggers update of the CSR register
in the Partial Reconfiguration Region Controller.

Source bridge without packet transfer When the freeze signal is high, the Freeze Bridge does not send
transactions to the static region. The Freeze Bridge remains idle until the
bridge leaves the frozen state.

Source bridge with max_channel > 1 When multiple channels transfer unfinished transactions, the Freeze Bridge
tracks the channel values to ensure that all packet transactions from
different channels end by asserting the endofpacket bit during the frozen
state.

Source bridge with ready_latency > 0 When the Freeze Bridge drives endofpacket, valid, or channel outputs
to the static region, the Freeze Bridge reads the ready_latency value. The
ready_latency value defines the actual clock cycle sink component ready
for data.
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Figure 56. Source Bridge Handling of Unfinished Packet Transaction During Freeze
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Figure 57. PR Freeze Bridge Asserting valid Signal to End Packet Transactions
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Table 54. Avalon-ST Sink Freeze Bridge Interface Behavior

Interface Type Behavior

Sink Bridge For transactions that includes packet transfers, when the freeze signal goes
high, the Freeze Bridge holds the ready signal high until any unfinished
transaction completes.
For transactions that do not include packet transfers, when the freeze
signal goes high, the Freeze Bridge holds the ready signal low during the
freeze period.
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Interface Type Behavior

The illegal_request signal asserts high to indicate that the current
transaction is an error. Configure the design to stop sending transactions to
the PR region after the illegal_request signal is high.

Sink bridge with ready_latency > 0 When the Freeze Bridge drives endofpacket, valid, or channel outputs
to the static region, the Freeze Bridge must observe the ready_latency
value. The ready_latency value defines the actual clock cycle sink
component ready for data.

2.7.1. Parameters: Avalon-ST Partial Reconfiguration Freeze Bridge

The Avalon-ST Partial Reconfiguration Freeze Bridge IP core supports customization of
the following parameters.

Figure 58. Parameter Editor
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Table 55. Avalon-ST Partial Reconfiguration Freeze Bridge Parameters

Parameter Values Description

PR region Interface Type Avalon-ST Source/Avalon-
ST Sink

Specifies the interface type for interfacing with the
freeze bridge.

Enable Freeze port from PR
region

On/Off Enables the freeze port to freeze all the outputs of
each PR region to a known constant value. Freezing
prevents the signal receivers in the static region
from receiving undefined signals during the partial
reconfiguration process.

Select Yes or No to enable or
disable interface ports

Yes/No Enables or disables specific optional freeze bridge
interface ports.

Channel width <1-128> Specifies the width of the channel signal.

Error width <1-256> Specifies the width of the error signal.

Data bits per symbol <1-512> Specifies the number of bits per symbol.

Symbols per beat <1-512> Specifies the number of symbols that transfer on
every valid clock cycle.

Error descriptors <text> Specifies one or more strings to describe the error
condition for each bit of the error port on the sink
interface connected to the source interface. Click
the plus or minus buttons to add or remove
descriptors.

Max channel number <0-255> Specifies the maximum number of output channels.

Ready latency <0-8> Specifies what ready latency to expect from the
source interface connected to the sink interface.
The ready latency is the number of cycles from the
time ready asserts until valid data is driven.

2.7.2. Ports: Avalon-ST Partial Reconfiguration Freeze Bridge

Figure 59. Avalon-ST Sink Interface Ports
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Figure 60. Avalon-ST Source Interface Ports

Table 56. Avalon-ST Partial Reconfiguration Freeze Bridge Interface Ports

Port Width Direction Description

clock 1 Input Input clock for the IP.

freeze_conduit_freeze 1 Input When this signal is high, the bridge handles
any current transaction properly then
freezes the PR interfaces.

freeze_conduit_illegal_request 1 Output High on this bus indicate that an illegal
request is issued to the bridge during
freezing state.
n – number of freeze bridge

pr_freeze_pr_freeze 1 Input Enabled freeze port from the PR region.

reset_n 1 Input Synchronous reset for the IP.

Table 57. Avalon-ST Sink to Static Region Interface Ports
Same setting as Avalon-ST sink to PR region interface.

Port Width Direction Description

sink_bridge_to_sr_channel 1 Input Avalon-ST sink bridge to static region
channel port.

sink_bridge_to_sr_data 32 Input Avalon-ST sink bridge to static region data
port.

sink_bridge_to_sr_empty 2 Input Avalon-ST sink bridge to static region empty
port.

sink_bridge_to_sr_error 1 Input Avalon-ST sink bridge to static region error
port.

sink_bridge_to_sr_ready 1 Output Avalon-ST sink bridge to static region ready
port.

continued...   
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Port Width Direction Description

sink_bridge_to_sr_valid 1 Input Avalon-ST sink bridge to static region valid
port.

sink_bridge_to_sr_endofpacket 1 Input Avalon-ST sink bridge to static region
endofpacket port.

sink_bridge_to_sr_startofpacket 1 Input Avalon-ST sink bridge to static region
startofpacket port.

Table 58. Avalon-ST Sink to PR Region Interface Ports

Port Width Direction Description

sink_bridge_to_pr_channel 1 Output Optional Avalon-ST sink bridge to PR region
channel port.

sink_bridge_to_pr_data 32 Output Optional Avalon-ST sink bridge to PR region
data port.

sink_bridge_to_pr_empty 2 Output Optional Avalon-ST sink bridge to PR region
empty port.

sink_bridge_to_pr_error 1 Output Optional Avalon-ST sink bridge to PR region
error port.

sink_bridge_to_pr_ready 1 Input Optional Avalon-ST sink bridge to PR region
ready port.

sink_bridge_to_pr_valid 1 Output Optional Avalon-ST sink bridge to PR region
valid port.

sink_bridge_to_pr_endofpacket 1 Output Optional Avalon-ST sink bridge to PR region
endofpacket port.

sink_bridge_to_pr_startofpacket 1 Output Optional Avalon-ST sink bridge to PR region
startofpacket port.

Table 59. Avalon-ST Source to Static Region Interface Ports
Same setting as Avalon-ST source to PR region interface.

Port Width Direction Description

source_bridge_to_sr_channel 1 Output Avalon-ST source bridge to static region
channel port.

source_bridge_to_sr_data 32 Output Avalon-ST source bridge to static region
data port.

source_bridge_to_sr_empty 2 Output Avalon-ST source bridge to static region
empty port.

source_bridge_to_sr_error 1 Output Avalon-ST source bridge to static region
error port.

source_bridge_to_sr_ready 1 Input Avalon-ST source bridge to static region
ready port.

source_bridge_to_sr_valid 1 Output Avalon-ST source bridge to static region
valid port.

source_bridge_to_sr_endofpacket 1 Output Avalon-ST source bridge to static region
endofpacket port.

source_bridge_to_sr_startofpacket 1 Output Avalon-ST source bridge to static region
startofpacket port.

2. Partial Reconfiguration Solutions IP User Guide

UG-20136 | 2018.08.07

Partial Reconfiguration User Guide Intel® Quartus® Prime Pro Edition
98



Table 60. Avalon-ST Source to PR Region Interface Ports

Port Width Direction Description

source_bridge_to_pr_channel 1 Input Optional Avalon-ST source bridge to PR
region channel port.

source_bridge_to_pr_data 32 Input Optional Avalon-ST source bridge to PR
region data port.

source_bridge_to_pr_empty 2 Input Optional Avalon-ST source bridge to PR
region empty port.

source_bridge_to_pr_error 1 Input Optional Avalon-ST source bridge to PR
region error port.

source_bridge_to_pr_ready 1 Output Optional Avalon-ST source bridge to PR
region ready port.

source_bridge_to_pr_valid 1 Input Optional Avalon-ST source bridge to PR
region valid port.

source_bridge_to_pr_endofpacket 1 Input Optional Avalon-ST source bridge to PR
region endofpacket port.

source_bridge_to_pr_startofpacket 1 Input Optional Avalon-ST source bridge to PR
region startofpacket port.

2.8. Generating and Simulating Intel FPGA IP

Use the following information to generate and simulate an IP core variation.

2.8.1. Generating IP Cores (Intel Quartus Prime Pro Edition)

Quickly configure Intel FPGA IP cores in the Intel Quartus Prime parameter editor.
Double-click any component in the IP Catalog to launch the parameter editor. The
parameter editor allows you to define a custom variation of the IP core. The parameter
editor generates the IP variation synthesis and optional simulation files, and adds
the .ip file representing the variation to your project automatically.

Follow these steps to locate, instantiate, and customize an IP core in the parameter
editor:

1. Create or open an Intel Quartus Prime project (.qpf) to contain the instantiated
IP variation.

2. In the IP Catalog (Tools ➤ IP Catalog), locate and double-click the name of the
IP core to customize. To locate a specific component, type some or all of the
component’s name in the IP Catalog search box. The New IP Variation window
appears.

3. Specify a top-level name for your custom IP variation. Do not include spaces in IP
variation names or paths. The parameter editor saves the IP variation settings in a
file named <your_ip>.ip. Click OK. The parameter editor appears.
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Figure 61. IP Parameter Editor (Intel Quartus Prime Pro Edition)

4. Set the parameter values in the parameter editor and view the block diagram for
the component. The Parameterization Messages tab at the bottom displays any
errors in IP parameters:

• Optionally, select preset parameter values if provided for your IP core. Presets
specify initial parameter values for specific applications.

• Specify parameters defining the IP core functionality, port configurations, and
device-specific features.

• Specify options for processing the IP core files in other EDA tools.

Note: Refer to your IP core user guide for information about specific IP core
parameters.

5. Click Generate HDL. The Generation dialog box appears.

6. Specify output file generation options, and then click Generate. The synthesis and
simulation files generate according to your specifications.

7. To generate a simulation testbench, click Generate ➤ Generate Testbench
System. Specify testbench generation options, and then click Generate.

8. To generate an HDL instantiation template that you can copy and paste into your
text editor, click Generate ➤ Show Instantiation Template.

9. Click Finish. Click Yes if prompted to add files representing the IP variation to
your project.

10. After generating and instantiating your IP variation, make appropriate pin
assignments to connect ports.
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Note: Some IP cores generate different HDL implementations according to the IP
core parameters. The underlying RTL of these IP cores contains a unique
hash code that prevents module name collisions between different variations
of the IP core. This unique code remains consistent, given the same IP
settings and software version during IP generation. This unique code can
change if you edit the IP core's parameters or upgrade the IP core version.
To avoid dependency on these unique codes in your simulation environment,
refer to Generating a Combined Simulator Setup Script.

Related Information

• Introduction to Intel FPGA IP Cores

• Generating a Combined Simulator Setup Script

2.8.2. Running the Freeze Bridge Update script

When instantiating the Freeze Bridge as a Platform Designer system component, the
interface connections between the Freeze Bridge and the PR region must match, so
that Platform Designer inserts no extra interconnect during system generation. Rather
than manually matching the Avalon interface properties individually in the parameter
editor, you can run the provided Update Freeze Bridge Parameters script to update
Freeze Bridge Avalon interface properties automatically.

Running this script updates the master and slave interfaces or the sink and source
interfaces of the Freeze Bridge, according to the Avalon property settings of the
connecting PR region component.

To run the Update Freeze Bridge Parameters script:

1. Open a Platform Designer system containing one or more instances of the Freeze
Bridge component.

2. In Platform Designer, click View ➤ System Scripting. The System Scripting
tab displays Platform Designer Built-in Scripts.

3. To update all freeze bridges in your Platform Designer system, set
update_all_freeze_bridges 1 in the Additional Commands section of the
script. To update only a single freeze bridge, click the freeze bridge instance.

4. Click Run Script. The script runs and updates the freeze bridge parameters.
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Figure 62. Platform Designer System Scripting Tab

2.8.3. IP Core Generation Output (Intel Quartus Prime Pro Edition)

The Intel Quartus Prime software generates the following output file structure for
individual IP cores that are not part of a Platform Designer system.
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Figure 63. Individual IP Core Generation Output (Intel Quartus Prime Pro Edition)

<Project Directory>

<your_ip>_inst.v or .vhd - Lists file for IP core synthesis

<your_ip>.qip  - Lists files for IP core synthesis

synth - IP synthesis files

<IP Submodule>_<version> - IP Submodule Library 

sim

<your_ip>.v or .vhd - Top-level IP synthesis file

sim - IP simulation files

<simulator vendor> - Simulator setup scripts
<simulator_setup_scripts>

<your_ip> - IP core variation files

<your_ip>.ip - Top-level IP variation file

<your_ip>_generation.rpt - IP generation report

<your_ip>.bsf - Block symbol schematic file 

<your_ip>.ppf - XML I/O pin information file

<your_ip>.spd - Simulation startup scripts

*

<your_ip>.cmp  - VHDL component declaration

<your_ip>.v or vhd - Top-level simulation file

synth

 - IP submodule 1 simulation files

 - IP submodule 1 synthesis files

<your_ip>_bb.v - Verilog HDL black box EDA synthesis file

<HDL files>

<HDL files>

<your_ip>_tb - IP testbench system *

<your_testbench>_tb.qsys - testbench system file
<your_ip>_tb - IP testbench files

your_testbench> _tb.csv or .spd - testbench file

sim - IP testbench simulation files
 *  If supported and enabled for your IP core variation.

<your_ip>.qgsimc - Simulation caching file (Platform Designer)

<your_ip>.qgsynthc  - Synthesis caching file (Platform Designer)

Table 61. Output Files of Intel FPGA IP Generation

File Name Description

<your_ip>.ip Top-level IP variation file that contains the parameterization of an IP core in
your project. If the IP variation is part of a Platform Designer system, the
parameter editor also generates a .qsys file.

<your_ip>.cmp The VHDL Component Declaration (.cmp) file is a text file that contains local
generic and port definitions that you use in VHDL design files.

<your_ip>_generation.rpt IP or Platform Designer generation log file. Displays a summary of the
messages during IP generation.
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File Name Description

<your_ip>.qgsimc (Platform Designer
systems only)

Simulation caching file that compares the .qsys and .ip files with the current
parameterization of the Platform Designer system and IP core. This comparison
determines if Platform Designer can skip regeneration of the HDL.

<your_ip>.qgsynth (Platform
Designer systems only)

Synthesis caching file that compares the .qsys and .ip files with the current
parameterization of the Platform Designer system and IP core. This comparison
determines if Platform Designer can skip regeneration of the HDL.

<your_ip>.qip Contains all information to integrate and compile the IP component.

<your_ip>.csv Contains information about the upgrade status of the IP component.

<your_ip>.bsf A symbol representation of the IP variation for use in Block Diagram Files
(.bdf).

<your_ip>.spd Input file that ip-make-simscript requires to generate simulation scripts.
The .spd file contains a list of files you generate for simulation, along with
information about memories that you initialize.

<your_ip>.ppf The Pin Planner File (.ppf) stores the port and node assignments for IP
components you create for use with the Pin Planner.

<your_ip>_bb.v Use the Verilog blackbox (_bb.v) file as an empty module declaration for use
as a blackbox.

<your_ip>_inst.v or _inst.vhd HDL example instantiation template. Copy and paste the contents of this file
into your HDL file to instantiate the IP variation.

<your_ip>.regmap If the IP contains register information, the Intel Quartus Prime software
generates the .regmap file. The .regmap file describes the register map
information of master and slave interfaces. This file complements
the .sopcinfo file by providing more detailed register information about the
system. This file enables register display views and user customizable statistics
in System Console.

<your_ip>.svd Allows HPS System Debug tools to view the register maps of peripherals that
connect to HPS within a Platform Designer system.
During synthesis, the Intel Quartus Prime software stores the .svd files for
slave interface visible to the System Console masters in the .sof file in the
debug session. System Console reads this section, which Platform Designer
queries for register map information. For system slaves, Platform Designer
accesses the registers by name.

<your_ip>.v <your_ip>.vhd HDL files that instantiate each submodule or child IP core for synthesis or
simulation.

mentor/ Contains a msim_setup.tcl script to set up and run a ModelSim* simulation.

aldec/ Contains a Riviera-PRO* script rivierapro_setup.tcl to setup and run a
simulation.

/synopsys/vcs

/synopsys/vcsmx

Contains a shell script vcs_setup.sh to set up and run a VCS* simulation.
Contains a shell script vcsmx_setup.sh and synopsys_sim.setup file to
set up and run a VCS MX simulation.

/cadence Contains a shell script ncsim_setup.sh and other setup files to set up and
run an NCSim simulation.

/xcelium Contains an Xcelium* Parallel simulator shell script xcelium_setup.sh and
other setup files to set up and run a simulation.

/submodules Contains HDL files for the IP core submodule.

<IP submodule>/ Platform Designer generates /synth and /sim sub-directories for each IP
submodule directory that Platform Designer generates.
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2.8.4. Intel Arria 10 PR Control Block Simulation Model

The Intel Quartus Prime Pro Edition software supports simulating the delivery of a
partial reconfiguration bitstream to the PR control block. This simulation allows you to
observe the resulting change and the intermediate effect in a reconfigurable partition.

The Intel Arria 10 PR control block supports PR simulation. Sending a simulation RBF
(PR bitstream) allows the PR control block to behave accordingly, to PR simulation
success or PR simulation failure. To activate simulation of a specific PR persona in your
PR region simulation wrapper, use a PR ID encoded in the simulation RBF, in
conjunction with the PR control block. Simulate the PR control block either as
standalone, or as part of the simulation file set for the Intel Arria 10 Partial
Reconfiguration Controller IP core.

Figure 64. Intel Arria 10 PR Control Block Simulation Model
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The Intel Arria 10 PR control block simulation model contains two additional
simulation-only ports—sim_state and sim_pr_id. Connect these simulation ports,
and the other ports, to the twentynm_prblock_if SystemVerilog interface. This
connection allows monitoring of the PR control block using your testbench’s PR control
block monitor. The Intel Quartus Prime software automatically instantiates the
twentynm_prblock_if interface when generating the simulation file set of the Intel
Arria 10 Partial Reconfiguration IP core. Obtain a reference to the
twentynm_prblock_if that the IP instantiates by using the
alt_pr_test_pkg::twentynm_prblock_if_mgr singleton, as shown in the
following example:

virtual twentynm_prblock_if prblock_if;

alt_pr_test_pkg::twentynm_prblock_if_mgr cb_mgr;

// Get the PR control block from the prblock manager
cb_mgr = alt_pr_test_pkg::twentynm_prblock_if_mgr::get();
prblock_if = cb_mgr.if_ref;

The code for the twentynm_prblock_if interface is as follows:

interface twentynm_prblock_if(input logic pr_clk, input logic clk);

    logic prrequest;
    logic [31:0] data;
    wire error;
    wire ready;
    wire done;
    logic [31:0] sim_only_state;
    wire [31:0] sim_only_pr_id;

    // All signals are async except data
    clocking cb1 @(posedge pr_clk);
        output data;

2. Partial Reconfiguration Solutions IP User Guide

UG-20136 | 2018.08.07

Partial Reconfiguration User Guide Intel® Quartus® Prime Pro Edition
105



    endclocking
    
endinterface : twentynm_prblock_if

For more information on the twentynm_prblock_if interface, refer to the
<installation directory>/eda/sim_lib/altera_lnsim.sv file.

The simulation state of the Intel Arria 10 PR control block simulation model represents
the PR_EVENT_TYPE enumeration state of the control block. The
twentynm_prblock_test_pkg SystemVerilog package defines these enumerations.
These states represent the different allowed states for the control block. The defined
control block enumerations are:

package twentynm_prblock_test_pkg;
    typedef enum logic [31:0] {
        NONE,
        IDLE,
        PR_REQUEST,
        PR_IN_PROGRESS,
        PR_COMPLETE_SUCCESS,
        PR_COMPLETE_ERROR,
        PR_INCOMPLETE_EARLY_WITHDRAWL,
        PR_INCOMPLETE_LATE_WITHDRAWL
    } PR_EVENT_TYPE;

When the simulation state is PR_IN_PROGRESS, the affected PR region must have its
simulation output multiplexes driven to X, by asserting the pr_activate signal. This
action simulates the unknown outputs of the PR region during partial reconfiguration.
In addition, you must assert the pr_activate signal in the PR simulation model to
load all registers in the PR model with the PR activation value.

Once the simulation state reaches PR_COMPLETE_SUCCESS, activate the appropriate
PR persona using the appropriate PR region simulation wrapper mux sel signals. You
can decode the region, as well as the specific select signal from the sim_only_pr_id
signal of the PR control block. This ID corresponds to the encoded ID in the simulation
RBF.

Table 62. Required Sequence of Words in Simulation RBF
Step 1 writes zero or more of the following words. All other steps write only 1 word.

1 zero padding blocks 0x00000000

2 PR_HEADER_WORD 0x0000A65C

3 PR_ID 32-bit user ID

4 PRDATA_COUNT_0 0x01234567

5 PRDATA_COUNT_1 0x89ABCDEF

6 PRDATA_COUNT_2 0x02468ACE

7 PRDATA_COUNT_3 0x13579BDF

Note: The PR_ID word is output on the sim_only_pr_id word, starting at
PRDATA_COUNT_0. Using a different value for the header or data count results in PR
simulation errors.

Related Information

• Simulating PR Persona Replacement on page 38
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• Simulating Intel FPGA IP Cores

• Partial Reconfiguration Simulation and Verification

2.8.5. Generating the PR Persona Simulation Model

Use the Intel Quartus Prime EDA Netlist Writer to create the simulation model for a PR
persona. The simulation model represents the post-synthesis, gate-level netlist for the
persona.

When using the PR simulation model for the persona, the netlist includes a new
altera_sim_pr_activate top-level signal for the model. You can asynchronously
drive this signal to load all registers in the model with X. This feature allows you to
verify the reset sequence of the new persona on PR event completion. Verify the reset
sequence through inspection, using SystemVerilog assertions, or using other checkers.

By default, the PR simulation model asynchronously loads X into the register’s storage
element on pr_activate signal assertion. You can parameterize this behavior on a
per register basis, or on a simulation-wide default basis. The simulation model
supports four built-in modes:

• load X

• load 1

• load 0

• load rand

Specify these modes using the SystemVerilog classes:

• dffeas_pr_load_x

• dffeas_load_1

• dffeas_load_0

• dffeas_load_rand

Optionally, you can create your own PR activation class, where your class must define
the pr_load variable to specify the PR activation value.

Follow these steps to generate the simulation model for a PR design:

1. Open the base revision of a PR project in Intel Quartus Prime Pro Edition, and then
click Processing ➤ Start ➤ Start Analysis & Synthesis. Alternatively, run this
command-line equivalent:

quartus_syn <project name> -c <base revision name>

2. After synthesis is complete, click Project ➤ Export Design Partition, and then
select the root partition for the Partition name, and select synthesized for the
Snapshot. Click OK. Alternatively, run this command-line equivalent:

quartus_cdb <project name> -c <base revision name> \
     "--export_block root_partition --snapshot synthesized \
     --file <static qdb name>

3. Click Project ➤ Revisions and switch the current revision to that of the persona
you want to export.
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4. Click Processing ➤ Start ➤ Start Analysis & Synthesis. Alternatively, run this
command-line equivalent:

quartus_syn <project name> -c <persona revision name>

5. After synthesis of the persona revision completes, execute the following at the
command line to generate the PR simulation model:

quartus_eda <project name> –c <persona revision name> "--pr --simulation \
     --tool=modelsim --format=verilog --partition=<pr partition name> \
     --module=<partition name>=<persona module name>

6. Repeat steps 3 through 5 for all personas that you want to simulate.

Example 7. Complete PR Simulation Model Generation Script

quartus_syn <project name> -c <base revision name>
quartus_cdb <project name> -c <base revision name> \
     "--export_block root_partition --snapshot synthesized \
     --file <static qdb name>
quartus_syn <project name> -c <persona revision name>
quartus_eda <project name> –c <persona revision name> \
     "--pr --simulation --tool=modelsim --format=verilog \
     --partition=<pr partition name> --module=<partition name>=\
     <persona module name>
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2018.06.18 18.0.0 • Corrected syntax error in Generating the PR Persona Simulation Model.

2018.05.07 18.0.0 • Added description of new Partial Reconfiguration External Configuration
Controller Intel Stratix 10 FPGA IP.

• Updated names of Partial Reconfiguration Controller Intel Arria 10 FPGA
IP and Partial Reconfiguration Controller Intel Stratix 10 FPGA IP.

• Enhanced explanation of Auto-instantiate CRC block Partial
Reconfiguration Controller Intel Arria 10 parameter.

• Added as chapter in new Partial Reconfiguration User Guide.
• Added note about recovery after PR error when using SEU detection in

Intel Stratix 10 designs.

2017.11.06 17.1.0 • Added support for Intel Stratix 10 Partial Reconfiguration Controller IP
core.

• Updated for latest Intel product naming conventions.

2017.05.08 17.0.0 Initial public release.
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A. Intel Quartus Prime Pro Edition User Guides
Refer to the following user guides for comprehensive information on all phases of the
Intel Quartus Prime Pro Edition FPGA design flow.

Related Information

• Getting Started User Guide
Introduces the basic features, files, and design flow of the Intel Quartus Prime
Pro Edition software, including managing Intel Quartus Prime Pro Edition
projects and IP, initial design planning considerations, and project migration
from previous software versions.

• Platform Designer User Guide
Describes creating and optimizing systems using Platform Designer, a system
integration tool that simplifies integrating customized IP cores in your project.
Platform Designer automatically generates interconnect logic to connect
intellectual property (IP) functions and subsystems.

• Design Recommendations User Guide
Describes best design practices for designing FPGAs with the Intel Quartus
Prime Pro Edition software. HDL coding styles and synchronous design
practices can significantly impact design performance. Following recommended
HDL coding styles ensures that Intel Quartus Prime Pro Edition synthesis
optimally implements your design in hardware.

• Compiler User Guide
Describes set up, running, and optimization for all stages of the Intel Quartus
Prime Pro Edition Compiler. The Compiler synthesizes, places, and routes your
design before generating a device programming file.

• Design Optimization User Guide
Describes Intel Quartus Prime Pro Edition settings, tools, and techniques that
you can use to achieve the highest design performance in Intel FPGAs.
Techniques include optimizing the design netlist, addressing critical chains that
limit retiming and timing closure, and optimization of device resource usage.

• Programmer User Guide
Describes operation of the Intel Quartus Prime Pro Edition Programmer, which
allows you to configure Intel FPGA devices, and program CPLD and
configuration devices, via connection with an Intel FPGA download cable.

• Block-Based Design User Guide
Describes block-based design flows, also known as modular or hierarchical
design flows. These advanced flows enable preservation of design blocks (or
logic that comprises a hierarchical design instance) within a project, and reuse
of design blocks in other projects.
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• Partial Reconfiguration User Guide
Describes Partial Reconfiguration, an advanced design flow that allows you to
reconfigure a portion of the FPGA dynamically, while the remaining FPGA
design continues to function. Define multiple personas for a particular design
region, without impacting operation in other areas.

• Third-party Simulation User Guide
Describes RTL- and gate-level design simulation support for third-party
simulation tools by Aldec*, Cadence*, Mentor Graphics*, and Synopsys* that
allow you to verify design behavior before device programming. Includes
simulator support, simulation flows, and simulating Intel FPGA IP.

• Third-party Synthesis User Guide
Describes support for optional synthesis of your design in third-party synthesis
tools by Mentor Graphics*, and Synopsys*. Includes design flow steps,
generated file descriptions, and synthesis guidelines.

• Debug Tools User Guide
Describes a portfolio of Intel Quartus Prime Pro Edition in-system design
debugging tools for real-time verification of your design. These tools provide
visibility by routing (or “tapping”) signals in your design to debugging logic.
These tools include System Console, Signal Tap logic analyzer, Transceiver
Toolkit, In-System Memory Content Editor, and In-System Sources and Probes
Editor.

• Timing Analyzer User Guide
Explains basic static timing analysis principals and use of the Intel Quartus
Prime Pro Edition Timing Analyzer, a powerful ASIC-style timing analysis tool
that validates the timing performance of all logic in your design using an
industry-standard constraint, analysis, and reporting methodology.

• Power Analysis and Optimization User Guide
Describes the Intel Quartus Prime Pro Edition Power Analysis tools that allow
accurate estimation of device power consumption. Estimate the power
consumption of a device to develop power budgets and design power supplies,
voltage regulators, heat sink, and cooling systems.

• Design Constraints User Guide
Describes timing and logic constraints that influence how the Compiler
implements your design, such as pin assignments, device options, logic
options, and timing constraints. Use the Interface Planner to prototype
interface implementations, plan clocks, and quickly define a legal device
floorplan. Use the Pin Planner to visualize, modify, and validate all I/O
assignments in a graphical representation of the target device.

• PCB Design Tools User Guide
Describes support for optional third-party PCB design tools by Mentor
Graphics* and Cadence*. Also includes information about signal integrity
analysis and simulations with HSPICE and IBIS Models.

• Scripting User Guide
Describes use of Tcl and command line scripts to control the Intel Quartus
Prime Pro Edition software and to perform a wide range of functions, such as
managing projects, specifying constraints, running compilation or timing
analysis, or generating reports.
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